The software supplied with this document is the property of RadView Software and is furnished under a licensing agreement. Neither the software nor this document may be copied or transferred by any means, electronic or mechanical, except as provided in the licensing agreement. The information in this document is subject to change without prior notice and does not represent a commitment by RadView Software or its representatives.

WebLOAD Analytics User Guide

© Copyright 2014 by RadView Software. All rights reserved.

March, 2014, RadView Publication Number WLPRO-1013–AUG84

WebLOAD, TestTalk, Authoring Tools, ADL, AppletLoad, and WebExam, are trademarks or registered trademarks of RadView Software IBM, and OS/2 are trademarks of International Business Machines Corporation. Microsoft Windows, Microsoft Windows 95, Microsoft Windows NT, Microsoft Word for Windows, Microsoft Internet Explorer, Microsoft Excel for Windows, Microsoft Access for Windows and Microsoft Access Runtime are trademarks or registered trademarks of Microsoft Corporation. SPIDERSESSION is a trademark of NetDynamics. UNIX is a registered trademark of AT&T Bell Laboratories. Solaris, Java and Java–based marks are registered trademarks of Sun Microsystems, Inc. HP–UX is a registered trademark of Hewlett–Packard. SPARC is a registered trademark of SPARC International, Inc. Netscape Navigator and LiveConnect are registered trademarks of Netscape Communications Corporation. iReport is a registered trademark of JasperSoft Corporation. Any other trademark name appearing in this book is used for editorial purposes only and to the benefit of the trademark owner with no intention of infringing upon that trademark.

For product assistance or information, contact:

<table>
<thead>
<tr>
<th>North American Headquarters:</th>
<th>International Headquarters:</th>
</tr>
</thead>
<tbody>
<tr>
<td>RadView Software Inc.</td>
<td>RadView Software Ltd.</td>
</tr>
<tr>
<td>991 Highway 22 West, Suite 200</td>
<td>14 Hamelacha Street, Park Afek</td>
</tr>
<tr>
<td>Bridgewater, NJ 08807</td>
<td>Rosh Haayin, Israel 48091</td>
</tr>
<tr>
<td>Email: <a href="mailto:info@RadView.com">info@RadView.com</a></td>
<td>Email: <a href="mailto:info@RadView.com">info@RadView.com</a></td>
</tr>
<tr>
<td>Phone: 908-526-7756</td>
<td>Phone: +972-3-915-7060</td>
</tr>
<tr>
<td>Fax: 908-864-8099</td>
<td>Fax: +972-3-915-7683</td>
</tr>
<tr>
<td>Toll Free: 1-888-RadView</td>
<td></td>
</tr>
</tbody>
</table>

Toll free in the US: 1-888-RadView
Fax: +1-908-864-8099
World Wide Web: www.RadView.com
# Table of Contents

## Chapter 1. Introduction

- WebLOAD Documentation ................................................................. 8
- Typographical Conventions .............................................................. 8
- Where to Get More Information ...................................................... 9
  - Online Help ................................................................................. 10
  - Technical Support Website .......................................................... 10
  - Technical Support ........................................................................ 11

## Chapter 2. WebLOAD Analytics System Overview

- The WebLOAD Analytics Workflow .................................................. 12
- The Analytics Repositories ............................................................... 15

## Chapter 3. Getting Started

- Launching WebLOAD Analytics ....................................................... 16
- Understanding the User Interface .................................................... 18
- Accessing Help ................................................................................ 19

## Chapter 4. Generating Charts

- Creating New Charts ........................................................................ 21
  - Specifying a Load Session ............................................................. 22
- Creating a Regression Chart .............................................................. 23
- Creating a Statistical Correlation Chart ............................................ 25
  - Specifying the Leading Measurement in a Statistical Correlation Chart .................................................. 27
- Printing a Chart .............................................................................. 27
- Creating an Interactive Chart from the Blank Template .................... 28
- Creating a Regression Chart from the Blank Regression Template .......... 29
- Navigating through a Chart ............................................................... 30
- Customizing Interactive Charts ....................................................... 31
- Publishing Charts .......................................................................... 33
Chapter 5. Changing Chart Settings .......................................................... 35
  Selecting Agendas – Static Chart .......................................................... 36
  Selecting Measurements – Interactive Chart ........................................ 37
  Filtering by Time .................................................................................. 39
  Filtering by Statistics-based Time ......................................................... 40
  Modifying Chart Parameters ............................................................... 43

Chapter 6. Generating Reports ................................................................. 45
  Creating New Reports .......................................................................... 45
  Printing a Report ................................................................................ 47
  Publishing Reports ............................................................................ 47
  Saving Reports ................................................................................... 48
  Opening Saved Reports ..................................................................... 49
    Opening Reports from the Recent Reports Tab .................................. 49
    Opening a Report From the File System ........................................... 50
  Modifying Report Appearance ........................................................... 50

Chapter 7. Working with Load Sessions ................................................... 51
  Importing Load Sessions .................................................................... 51
  Searching for Load Sessions ............................................................... 52
    Searching by Date ............................................................................ 52
    Searching by Session Name ............................................................ 53
  Deleting Load Sessions ...................................................................... 53

Chapter 8. Working with Templates .......................................................... 54
  Template Overview ............................................................................ 54
  Creating User-defined Templates ....................................................... 55
  Creating an Interactive Template from the Blank Template ................ 56
  Creating an Interactive Regression Template from the Blank Regression Template ......................................................... 57
  Managing Template Categories .......................................................... 59
    Creating New Template Categories ................................................ 59
    Copying Templates ........................................................................... 60
    Renaming Templates and Template Categories .................................. 60
    Deleting Templates and Template Categories .................................. 61
  Using JasperSoft iReport ................................................................... 61
  Importing New Templates ................................................................... 62

Chapter 9. Working with Portfolios .......................................................... 63
  Creating a Portfolio ............................................................................ 63
Opening a Portfolio........................................................................................................... 64

Chapter 10. Defining Your Preferences ................................................................................. 66
Defining Your Analytics Preferences.................................................................................. 66
Defining Your Database Preferences................................................................................ 69
Defining Your Parameter Preferences.............................................................................. 70

Appendix A. WebLOAD Analytics File System Structure .................................................. 77
WebLOAD Analytics File Structure................................................................................... 77

Appendix B. Understanding the Statistics .......................................................................... 80
Statistical Terms................................................................................................................. 80

Appendix C. Running Analytics in Command Line Mode .................................................. 81
WLAnalyticsCMD.exe ........................................................................................................ 81
  Syntax................................................................................................................................. 81
  Parameters......................................................................................................................... 81
  Examples............................................................................................................................ 83
WLAnalytics.exe ................................................................................................................ 83
  Syntax................................................................................................................................. 83
  Parameters......................................................................................................................... 84
  Examples............................................................................................................................ 84

Appendix D. Understanding the Templates.......................................................................... 85
Understanding Load Session Terminology ........................................................................ 85
General Templates............................................................................................................. 86
  Attempted Connections...................................................................................................... 87
  Connection Time................................................................................................................ 88
  General Session Information............................................................................................. 88
  HTTP Errors Over Time ................................................................................................... 88
  HTTP Responses............................................................................................................... 89
  HTTP Responses Over Time ............................................................................................. 89
  Load Size Summary .......................................................................................................... 89
  Performance Summary ..................................................................................................... 90
  Response Time Breakdown ............................................................................................... 90
Log and Errors Templates.................................................................................................. 91
Welcome to WebLOAD Professional, the premier performance, scalability, reliability testing solution for internet applications.

WebLOAD is easy to use and delivers maximum testing performance and value. WebLOAD verifies the scalability and integrity of internet applications by generating a load composed of Virtual Clients that simulate real-world traffic. Probing Clients let you refine the testing process by acting as a single user that measures the performance of targeted activities, and provides individual performance statistics of the internet application under load.

This section provides a brief introduction to WebLOAD technical support, including both documentation and online support.

**WebLOAD Documentation**

WebLOAD is supplied with the following documentation:

**WebLOAD™ Installation Guide**
Instructions for installing WebLOAD and its add-ons.

**WebLOAD™ IDE User Guide**
Instructions for recording, editing, and debugging load test Agendas to be executed by WebLOAD to test your Web-based applications.

**WebLOAD™ Console User Guide**
A guide to using WebLOAD console, RadView’s load/scalability testing tool to easily and efficiently test your Web-based applications. This guide also includes a quick start section containing instructions for getting started quickly with WebLOAD using the RadView Software test site.

**WebLOAD™ Analytics User Guide**
Instructions on how to use WebLOAD Analytics to analyze data and create custom, informative reports after running a WebLOAD test session.
WebRM™ User Guide

Instructions for managing testing resources with the WebLOAD Resource Manager.

WebLOAD™ Scripting Guide

Complete information on scripting and editing JavaScript Agendas for use in WebLOAD and WebLOAD IDE.

WebLOAD™ JavaScript Reference Guide

Complete reference information on all JavaScript objects, variables, and functions used in WebLOAD and WebLOAD IDE test Agendas.

WebLOAD™ Extensibility SDK

Instructions on how to develop extensions to tailor WebLOAD to specific working environments.

WebLOAD™ Automation Guide

Instructions for automatically running WebLOAD tests and reports from the command line, or by using the WebLOAD plugin for Jenkins.

The guides are distributed with the WebLOAD software in online help format. The guides are also supplied as Adobe Acrobat files. View and print these files using the Adobe Acrobat Reader. Install the Reader from the Adobe Web site http://www.adobe.com.

Typographical Conventions

Before you start using this guide, it is important to understand the terms, icons, and typographical conventions used in the documentation.

The following icons appear next to the text to identify special information.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Note Icon]</td>
<td>Indicates a note.</td>
</tr>
<tr>
<td>![Feature Icon]</td>
<td>Indicates a feature that is available only as part of a WebLOAD Add-on.</td>
</tr>
</tbody>
</table>
The following kinds of formatting in the text identify special information.

**Table 2: Typographical Conventions**

<table>
<thead>
<tr>
<th>Formatting convention</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Bold</td>
<td>Items you must select, such as menu options, command buttons, or items in a list.</td>
</tr>
<tr>
<td>Emphasis</td>
<td>Use to emphasize the importance of a point or for variable expressions such as parameters.</td>
</tr>
<tr>
<td>CAPITALS</td>
<td>Names of keys on the keyboard. for example, SHIFT, CTRL, or ALT.</td>
</tr>
<tr>
<td>KEY+KEY</td>
<td>Key combinations for which the user must press and hold down one key and then press another, for example, CTRL+P or ALT+F4.</td>
</tr>
</tbody>
</table>

**Where to Get More Information**

This section contains information on how to obtain technical support from RadView worldwide, should you encounter any problems.

**Online Help**

WebLOAD provides a comprehensive online help system with step-by-step instructions for common tasks.

You can press the **F1** key on any open window for an explanation of the options or select **Help > Contents** to open the online help contents and index.

**Technical Support Website**

The technical support pages on our website contain:

- FAQ (Frequently Asked / Answered Questions)
- Agenda Center
- Documentation
- RadView’s Product Resource Center, where you can find prepared test scripts, product information, and industry related news.
## Technical Support

For technical support in your use of this product, contact:

<table>
<thead>
<tr>
<th>North American Headquarters</th>
<th>International Headquarters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>e-mail:</strong> <a href="mailto:support@RadView.com">support@RadView.com</a></td>
<td><strong>e-mail:</strong> <a href="mailto:support@RadView.com">support@RadView.com</a></td>
</tr>
<tr>
<td><strong>Phone:</strong> 1-888-RadView</td>
<td><strong>Phone:</strong> +972-3-915-7060</td>
</tr>
<tr>
<td>(1-888-723-8439) (Toll Free)</td>
<td><strong>Fax:</strong> +972-3-915-7683</td>
</tr>
<tr>
<td>908-526-7756</td>
<td></td>
</tr>
<tr>
<td><strong>Fax:</strong> 908-864-8099</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** We encourage you to use e-mail for faster and better service. When contacting technical support please include in your message the full name of the product, as well as the version and build number.
WebLOAD accurately simulates Internet users’ behavior and models real-life demands on your Web application to predict capacity requirements, report bottlenecks, and detect weak links in your application before deployment. An important phase of the performance testing process is the analysis and reporting of test results. WebLOAD Analytics provides you with a simple yet comprehensive method of producing and publishing reports to fulfill all your analysis and reporting requirements.

Using WebLOAD Analytics, you can create clear, accurate, and meaningful reports that enable you to analyze Load Session results and identify peaks, trends, and anomalies in your data. WebLOAD Analytics provides you with a variety of predefined chart templates that enable you to produce focused reports on specific topics. You can edit these templates, and create new templates.

The WebLOAD Analytics Workflow

WebLOAD Analytics provides an easy to use, task oriented interface for the production and publication of Load Session reports. In a typical workflow, you create several charts of interest. Each is created simply by double-clicking a template. You then generate a Report, which is a compilation of the open charts.

The building blocks of the charts are:

- Load Sessions – WebLOAD Analytics uses Load Session data as the raw material for producing WebLOAD reports. Using WebLOAD Analytics, you can present Load Session results, compare various statistics, and highlight important results and conclusions, based on your load test results. For more information about Load Sessions, see Working with Load Sessions on page 51.

- Templates – A template specifies the design of a chart, including the visual layout, chart elements, and the way the data is structured. WebLOAD Analytics provides a wide range of predefined templates, based on RadView’s extensive knowledge and experience in the load testing and performance analysis fields. Predefined templates enable you to produce charts that focus on specific aspects of the Load Session data.
A basic chart consists of the following elements:

- **Tabular Data** – Provides a tabular representation of the Load Session data.
- **Graphs** – Provides a graphical representation of the Load Session data.

![Figure 1: WebLOAD Sample Chart](image)

Each chart is either static or interactive.

- A static chart, indicated by [image], is a regular chart.
- An interactive chart is indicated by [image]. It has the additional capability of enabling you to analyze and present the chart data in various ways using tools provided in its interactive toolbar.

Once you create all the charts necessary for your report, you can generate the report simply by clicking [image]. You then specify which of the open charts will be included in the report.

Reports can be saved for later use, with the defined Load Session data, template, and any optional settings you choose (see Saving Reports on page 48).
In addition, you can:

- **Apply filters to the Load Session data** – You can apply time and statistics-based filters to the Load Session data before the chart is produced. Time filters focus the chart on a specific part of the Load Session. Statistics-based time filters enable you to focus on time segments which meet defined criteria. For information about filtering your chart, see *Changing Chart Settings* on page 35.

- **Customize your graphs** – You can customize the graphs of interactive charts (denoted by the icon): change colors, line type, hide/show measurement, zoom and more. You can even add any other measurement from the session to the graphs.

- **Change the chart’s parameters** – each chart has different parameters that can be changed to control its behavior. Depending on the chart, you may add threshold values, control whether to show detailed data table or not, change titles and logos. For more information, see *Modifying Chart Parameters* on page 43.

- **Reuse your customizations** – You can change the settings of a template and then save it as a new template.

- **Create regression charts** – Adding multiple Load Sessions to a chart compares one selected session to all additional sessions included in the regression chart. This option is very useful for comparing two sessions that were run on the same Load Template. The purpose is to gauge whether a small change in the System Under Test has degraded the performance. For more information, see *Generating Charts* on page 21.

- **Create statistical correlation charts** – You can use these charts to identify measurements that have a high correlation with a certain measurement that is behaving in an unusual fashion, and are therefore possibly causing the unusual behavior of that measurement.

- **Print or Publish the chart or report** – Both charts and reports can be printed or published in a variety of formats, including DOC, ODT, PDF, HTML, RTF and XLSX. For information about printing charts and reports, see *Printing a Chart* on page 27 and *Printing a Report* on page 47. For information about publishing charts and Reports, see *Publishing Charts* on page 33 and *Publishing Reports* on page 47.

- **Group frequently used templates in a portfolio** – You can create a portfolio of templates that you use frequently. Opening the portfolio will open all its included templates. For information about how to set up a portfolio, see *Working with Portfolios* on page 63.

- **Manage your charts** – You can group your templates into different categories by creating your own folders and moving the templates you wish to use into those folders. You can also rename folders to create logical categories in which to group your templates. For information about managing your templates, see *Managing Template Categories* on page 59.
• **Assign and modify master templates** – WebLOAD Analytics contains three master templates: *Raw*, *WebLOAD*, and *WebLOAD with background*. Any one of these can be assigned as the master template for reports, and any one of these can be assigned as the master template for charts. By default, the reports master template is the *WebLOAD* master template, and the default charts master template is the *Raw* master template. The appearance of a report is determined only by the reports master template. The appearance of each chart is determined both by the chart master template and the settings of the specific template. You can specify which master template to assign to charts and which master template to assign to reports (see *Defining Your Analytics Preferences* on page 66). You can also change the values of some master template parameters (see *Defining Your Parameter Preferences* on page 70).

• **Create and edit static reports** – Although it is possible to dynamically define an interactive report from any measurement set, you can even create and edit the static templates. You can use the freely available iReport tool to edit the supplied templates and create new ones. For more information about JasperSoft iReport, see *Using JasperSoft iReport* on page 61.

---

**The Analytics Repositories**

All Load Sessions used with WebLOAD Analytics are stored in a database (PostgreSQL). These Load Sessions are the fundamental data for all reports generated by WebLOAD Analytics. Load Sessions are imported to the database through WebLOAD Analytics. A list of the Load Sessions stored in the database can be viewed from WebLOAD Analytics. For information about importing Load Sessions and selecting the Load Sessions you wish to work with, see *Working with Load Sessions* on page 51.

**Note:** You need to import Load Sessions to the database (also called the Load Session Repository) before they can be used by WebLOAD Analytics.

All chart templates are stored in the following directory, by default: `<WebLOAD data>Documents and Settings\All Users\Application Data\RadView\WebLOAD\Gallery`. This directory determines the appearance of the Templates Gallery. When you launch WebLOAD Analytics, the Gallery directory is scanned and all the templates therein are presented in the Templates Gallery. For information about modifying the default chart template location, see *Defining Your Analytics Preferences* on page 66. For more information about the Gallery directory, see *WebLOAD Analytics File System Structure* on page 77.

**Note:** The Gallery directory is not monitored while WebLOAD Analytics is running. RadView recommends not modifying this directory while WebLOAD Analytics is running.
WebLOAD Analytics provides a user friendly interface for creating your charts and reports, based on Load Session data. This section provides you with the information you need to start working with WebLOAD Analytics.

### Launching WebLOAD Analytics

You can launch WebLOAD Analytics quickly and easily from WebLOAD Console.

**Note:** WebLOAD Analytics is installed as part of the WebLOAD installation. For information about how to install WebLOAD, see the *WebLOAD Installation Guide*.

**To launch WebLOAD Analytics from WebLOAD Console:**

1. Select **Tools ▶️ Open WebLOAD Analytics,**
   - Or-
   
   Click the **WebLOAD Analytics** icon.

WebLOAD Analytics opens. The Session Load you were working on in the WebLOAD Console is automatically loaded into WebLOAD Analytics, and some charts analyzing the Load Session are displayed.
Figure 2: WebLOAD Analytics Screen
Understanding the User Interface

WebLOAD Analytics is designed to enable you to quickly and easily create, edit, print, publish, and manage charts and reports.

The user interface consists of the following elements:

- **Menu Bar** – Enables you to perform WebLOAD Analytics functions through the File, Edit, Window, and Help menus.
- **Main Toolbar** – This toolbar provides you with shortcuts to the main WebLOAD Analytics functions, including creating new charts, opening existing charts, and saving the reports on which you are working.
- **Navigation Area** – This area contains the Gallery, Current Report, and Recent Reports tabs. It displays the templates, current reports, and recently used reports available for use, depending on which tab you select.
- **Gallery Tab** – This tab displays all the templates and portfolios, organized in a hierarchical tree structure.
- **Current Report Tab** – This tab lists all the open charts in the Charts area. They are all grouped under a Report node.
- **Recent Reports Tab** – This tab lists all the previously saved Reports, each of which consists of a group of charts.
• **Charts Area** – This area displays all open charts. Each chart has its own tab, so you can easily switch between the different charts with which you are working. For information about creating, opening, saving, and viewing charts, see *Generating Charts* on page 21.

• **Chart Tab** – A tab is displayed for each open chart, showing the chart title. When a chart is selected, its settings are displayed in the Settings tab (Figure 12) and the generated chart is displayed in the Preview tab (Figure 3) and/or Chart View tab (Figure 4). The Preview tab shows the chart in its ready-to-print form. The Chart View tab, available only for interactive charts, enables manipulating the chart display in various ways.

You can easily resize or move the Charts area and Navigation area by dragging each component.

---

### Accessing Help

WebLOAD Analytics provides various help-related functions that enable you to access or display the following:

• **Help** – WebLOAD provides a comprehensive online help system with step-by-step instructions for common tasks.

  You can press F1 from any open window for an explanation of the options, or select **Help ➤ Help Contents** to open the online help contents and index.

• **Version Information** – Information about the version of WebLOAD Analytics that you are using, including copyright and licensing information, plugins, and configuration details. Select **Help ➤ About** to access this information.

• **WebLOAD Community Website** – Select **Help ➤ RadView.com** to access the website.

• **Professional Support** – Enables you to zip log files created by WebLOAD Analytics, for analysis by RadView support.

  • To create a zip of the WebLOAD Analytics log files, select **Help ➤ Create Log Zip**. A confirmation message specifying the location of the zip file appears.

WebLOAD Analytics creates three types of log files:

• Analytics log.

• Import Process Trace File (TRC) log.

• Eclipse Environment log.

WebLOAD Analytics provides a fast and easy way to move relevant log files to a zip file. The zip file can then be emailed to RadView Support, when required.
To automatically send a zip file of the WebLOAD Analytics log files to RadView support, select **Help ➤ Send Logs**. An automatic e-mail message is composed in your default e-mail program, with the zip file attached.
WebLOAD Analytics enables you to quickly and easily generate your charts in various formats. Using WebLOAD Analytics, you can create and view charts that are tailor made for your needs. You can then publish the charts in various formats, or create a report compiled of various charts, and publish the report (see Generating Reports on page 45).

Creating New Charts

To create a new chart, double-click a template in the Gallery tab (Figure 3). The chart is displayed in the Preview tab for a static chart, or in the Chart View tab for an interactive chart (Figure 4).

Note: If you did not open WebLOAD Analytics from WebLOAD Console, the Select sessions dialog appears and you are prompted to specify a Load Session (see Specifying a Load Session on page 22).
You can now:

- Modify the chart by editing chart settings and then regenerating the chart (see Changing Chart Settings on page 35).
- Print the chart (see Printing a Chart on page 27).
- Publish the chart to various formats (see Publishing Charts on page 33).
- For an interactive chart, you can analyze the chart data in various ways (see Customizing Interactive Charts on page 31).
- Create a report that will include the chart, as well as other open charts of your choice (see Generating Reports on page 45).

**Specifying a Load Session**

If you did not open WebLOAD Analytics from WebLOAD Console, the Select Session window appears the first time you double-click a template to create a chart.
To select a session:

1. Browse to the location of the Load Session file in the From File area, and click Open.
   - Or -

   Select the session in the From Repository area, and click OK.

   **Note:** You can search for Load Sessions (see *Searching for Load Sessions* on page 52).

---

**Creating a Regression Chart**

A regression chart compares one selected “Main” session to all additional sessions you specify. Regression charts are the only kind of chart that require you to specify multiple sessions for the generation of the chart.

**To create a regression chart:**

1. In the Templates Gallery, open the Session Comparison node located under the Templates node.
2. Double-click a regression template. The Select Sessions window appears.
3. Optionally browse to the location of a Load Session file in the From File area, and click **Open**.

   The Load Session file appears in the From Repository area.

4. Optionally search for Load Sessions (see *Searching for Load Sessions* on page 52).

5. In the From Repository area, select a Load Session you wish to use, and click **Add**.

   The Load Session moves to the Selected Sessions area. Repeat this step to include all the Load Sessions you wish to compare.

   The first session you select is set as the main Load Session. The main session appears in red. The main session is the session to which all other Load Sessions are compared.

6. To specify a different session as the main session, select the Load Session in the Selected Sessions area and click **Set as main**.

**To remove a Load Session from a regression chart:**

1. Select the regression chart in the Charts area.
2. Click the **Settings** tab.
3. Click \Select\... The Select Sessions window appears.

![Select Sessions window](image)

**Figure 7: Select Sessions**

4. Select the Load Session you wish to remove from the Selected Sessions area.

5. Click \Remove\... The selected Load Session is removed from the Selected Sessions area. It is still available for use in WebLOAD Analytics, and remains listed in the From Repository area.

---

**Creating a Statistical Correlation Chart**

Statistical correlation charts are used to identify measurements that have high correlation with a specified leading measurement, and are therefore suspect causes for the behavior of the leading measurement.
There are four predefined statistical correlation templates. They differ in the leading measurement (Response Time, Throughput), and in the graphical representation (over time or over the leading measurement). However, you can specify any measurement in any agenda to be the leading measurement, and you can view its correlation to all other measurements either over time or over the leading measurement.

Figure 8 shows a sample statistical correlation chart.

![Sample Statistical Correlation Chart](image)

Figure 8: Sample Statistical Correlation Chart

Note that you can specify which measurements to display in the graph, by selecting or deselecting them in the in the table at the bottom of the Chart view tab.

The table in the statistical correlation chart (Figure 8) displays correlation information in two columns – Correlation and Direction.

- **Correlation** is the linear correlation coefficient. It is a number between 0 and 1, with 1 being the highest possible correlation. The measurements are listed in order of correlation, with the highest first.

- **Direction** indicates whether correlation is positive (the measurement goes up when the leading measurement goes up, or down when the leading measurement goes down) or negative (the measurement goes up when the leading measurement goes down, or down when the leading measurement goes up).
**Example**

Suppose you notice a time frame in which throughput suddenly decreases. Generate a Throughput Correlation chart, use the Time Filter to view the relevant time period, and look for measurements with a high correlation.

- If HTTP Response 200 has also decreased correspondingly (positive Direction), which means the server is sending less OK results with requested data, while HTTP Response 500 has increased correspondingly, meaning the server is sending more short ‘internal error’ responses, then the increased inability to fill requests for data is probably what is causing decreased throughput.

**Specifying the Leading Measurement in a Statistical Correlation Chart**

To change the leading measurement in a statistical correlation chart:

1. Generate a statistical correlation chart.
2. Click the Settings tab.
3. Click Correlate To. The Custom X Axis Correlation window appears.
4. Select a measurement in an agenda.
5. Click OK.
6. Select a value for the X Axis. For example, select Time, or select Other and then specify the leading measurement.
7. Click . A correlation chart is generated for the measurement you selected.

**Note:** You may wish to apply a Time Filter that restricts the correlation calculation to a specific time frame, to better focus on a certain behavior of the leading measurement (refer to Filtering by Time on page 39). However, note that filtering a time period which is too short may harm accuracy.

**Printing a Chart**

You can print an open WebLOAD Analytics chart.

**To print a chart:**

1. In the Charts area, click the Chart View tab or Preview tab of an open chart.
2. Click . The Print window opens.
3. Specify the options you require, and click OK. The report is printed.

Creating an Interactive Chart from the Blank Template

You can create a new interactive chart based on the Blank Template. This template can be modified or you can use it to create additional custom interactive templates, as described in Creating an Interactive Template from the Blank Template on page 56.

Although you can modify any template to create your own custom chart, the Blank Template is unique in that its Measurement Selection area is empty.

To generate a chart based on the Blank Template:

1. In the Navigation area, click the Gallery tab. The Templates Gallery appears.

![Figure 9: Templates Gallery](image)

2. Select User Defined ▶ Blank Template. The Settings tab of the Blank Template opens in the Charts area.

3. Edit the Settings of the template as desired. See Changing Chart Settings on page 35. Note that you must specify at least one measurement (see Figure 14) in order to generate a chart.

4. Click . A progress window appears while the chart is generated. The chart is displayed in the Preview tab.

You can now analyze, print, or publish the chart.
For information about analyzing the chart, see *Customizing Interactive Charts* on page 31.

For information about printing your chart, see *Printing a Chart* on page 27.

For information about publishing your chart, see *Publishing Charts* on page 33.

---

**Creating a Regression Chart from the Blank Regression Template**

You can create a new interactive regression chart based on the Blank Regression Template. An interactive regression chart is both interactive, which means it enables you to analyze and customize the graph; and it is also a regression chart which means that it compares one selected session to all other specified sessions.

The Blank Regression Template can be modified or you can use it to create additional custom interactive regression templates, as described in *Creating an Interactive Regression Template from the Blank Regression Template* on page 57. Although you can modify any regression template to create your own custom regression template, the Blank Regression Template is unique in that it is interactive.

**To generate a regression chart based on the Blank Regression Template:**

1. In the Navigation area, click the **Gallery** tab. The Templates Gallery appears.
2. Select **User Defined ▶ Blank Regression Template**. The Select Sessions window appears (Figure 6).

3. Optionally browse to the location of a Load Session file in the From File area, and click **Open**.
   The Load Session file appears in the From Repository area.

4. Optionally search for Load Sessions (see **Searching for Load Sessions** on page 52).

5. In the From Repository area, select a Load Session you wish to use, and click **Add**.
   The Load Session moves to the Selected Sessions area. Repeat this step to include all the Load Sessions you wish to compare.

   The first session you select is set as the main Load Session. The main session appears in red. The main session is the session to which all other Load Sessions are compared.

6. To specify a different session as the main session, select the Load Session in the Selected Sessions area and click **Set as main**.

7. Edit the Settings of the template as desired. See **Changing Chart Settings** on page 35. Note that you must specify at least one measurement (see Figure 14) in order to create a template.

8. Click **Chart Preview**. A progress window appears while the chart is generated. The chart is displayed in the Preview tab.

   You can now analyze, print, or publish the chart.

   • For information about analyzing the chart, see **Customizing Interactive Charts** on page 31.
   • For information about printing your chart, see **Printing a Chart** on page 27.
   • For information about publishing your chart, see **Publishing Charts** on page 33.

---

**Navigating through a Chart**

You can view and navigate through a chart in the Preview tab.

**To view and navigate through a chart:**

1. Click the **Preview** tab.

   **Note:** If the chart is an interactive chart and a preview has not yet been generated, click the Chart View tab, then click **Preview**. A Preview tab appears.

2. Click the appropriate navigation button to navigate through your report, according to the information in Table 3.
Table 3: Viewing Options

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📚</td>
<td>Scroll to the beginning of your report.</td>
</tr>
<tr>
<td>👈</td>
<td>Scroll back one page.</td>
</tr>
<tr>
<td>🔄</td>
<td>Scroll forward one page.</td>
</tr>
<tr>
<td>👉</td>
<td>Scroll to the end of your report.</td>
</tr>
<tr>
<td>📄</td>
<td>Show the actual page size.</td>
</tr>
<tr>
<td>📄</td>
<td>Fit the page to the window.</td>
</tr>
<tr>
<td>📄</td>
<td>Fit the page width to the window.</td>
</tr>
<tr>
<td>🔍</td>
<td>Zoom in.</td>
</tr>
<tr>
<td>🔍</td>
<td>Zoom out.</td>
</tr>
</tbody>
</table>

Customizing Interactive Charts

The 📄 icon displayed adjacent to a template in the gallery indicates that a chart created with this template is an interactive chart. An interactive chart contains a toolbar, which provides a variety of tools for analyzing and presenting the data in the chart.

**To use the tools of an interactive chart:**

1. Click the **Chart View** tab.

**Note:** If the chart has not yet been generated, double-click the template. The chart is generated and displayed in the Chart View tab (Figure 11).
2. Click the appropriate button in the interactive toolbar, according to the information in Table 4.

3. To preserve the modifications you made to the chart display, click ![Save button](image). The modified chart appears in the Preview tab.

![Interactive Report – Chart View Tab](image)

**Figure 11: Interactive Report – Chart View Tab**

**Table 4: Interactive Toolbar Options**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Copy button](image) | Copy To Clipboard | Copy the chart or data to the clipboard. It can then be pasted (using Ctrl+V) into another application in any of the following formats:  
  - Bitmap – A raster graphic, which can be pasted into applications such as Microsoft Paint.  
  - Metafile – A vector graphic which can be pasted into applications such as Microsoft Word.  
  - Text – Data only, which can be pasted into applications such as Microsoft Excel. |
| ![Gallery button](image) | Gallery          | Change the line type to any type found in the gallery, such as bar-chart, area, etc. |
## Button Function Description

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Anti Aliasing</td>
<td>Smooth jagged edges.</td>
</tr>
<tr>
<td></td>
<td>Palette</td>
<td>Change all colors to a predefined palette from the list of palettes.</td>
</tr>
<tr>
<td></td>
<td>2D/3D</td>
<td>Switch between 2D mode and 3D mode with depth.</td>
</tr>
<tr>
<td></td>
<td>Rotated View</td>
<td>Rotate the chart. Only applicable in 3D mode.</td>
</tr>
<tr>
<td></td>
<td>Rotate X Axis</td>
<td>Rotate the chart around the X axis. Only applicable in Rotated View mode.</td>
</tr>
<tr>
<td></td>
<td>Rotate Y Axis</td>
<td>Rotate the chart around the Y axis. Only applicable in Rotated View mode.</td>
</tr>
<tr>
<td></td>
<td>Clustered</td>
<td>If there are several series, place them behind each other, instead of next to each other. Only applicable in 3D mode.</td>
</tr>
<tr>
<td></td>
<td>Axes Settings</td>
<td>Control aspects of the X Axis and Y Axis.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> In WebLOAD Analytics there is often more than one Y Axis, so the Y Axis setting has no effect. Instead, right-click the Y Axis you wish to change.</td>
</tr>
<tr>
<td></td>
<td>Point Label</td>
<td>Add labels with the numeric value of each point.</td>
</tr>
<tr>
<td></td>
<td>Data Editor</td>
<td>Show the data as a list.</td>
</tr>
<tr>
<td></td>
<td>Legend Box</td>
<td>Display a legend listing the series names, their color, and their marker shape.</td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td>Enlarge image. Click Zoom again to zoom out.</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
<td>Set the various chart settings.</td>
</tr>
</tbody>
</table>

### Publishing Charts

WebLOAD Analytics enables you to publish a chart in the following formats:

- Doc (Microsoft Word).
- PDF (Adobe Reader).
- XLSX (Excel). Please note the following:
  - The summary table (below the graph) is exported if it is displayed. To ensure that the summary table is displayed, set the SHOW_TABLES parameter to True (as described in *Defining Your Parameter Preferences* on page 70).
  - To work with the data more conveniently, change the Chart Preview master template to Raw (as described in *Defining Your Analytics Preferences* on page 66).
• XSL (Excel 97-2003). Note that it is preferable to use XSLX format whenever possible.
• HTML (Browser, Internet Explorer).
• RTF (Rich Text Format). Note that it is preferable to use Doc format whenever possible.
• ODT (Open Office).

**To publish a chart:**

1. In the Charts area, click the **Preview** tab.

   **Note:** If the chart is an interactive chart and a preview has not yet been generated, click the Chart View tab, then click 📌. A Preview tab appears.

2. Click 📌 to publish your chart as the default format specified in the Preferences window,
   - Or-
   Click the adjacent arrow to select a different format.

   The Save As window opens to the location specified in the Preferences window.

3. Select a location and name for your chart and click **Save**. The chart is published in the chosen format and saved to the location you specified.
Chapter 5
Changing Chart Settings

The Settings tab of a chart enables you to modify the chart by changing various chart settings.

• You can filter your Load Session data results in various ways. You can filter the results displayed in your chart by selecting specific Agendas or measurements within your Load Session, by applying time or statistics-based time filters. For example, you can focus your chart on a specific Agenda or time segment within the Load Session data and/or specify a threshold for one or more of the statistics used in the selected Load Session (such as Hits per second > 50). This enables you to produce charts that contain only the information you wish to present.

• You can also modify various chart parameters such as the time format, tolerance range, etc.

After you modify a chart’s settings, click or to regenerate the chart.

To change the settings of a chart:

1. Select the chart in the Charts area.
2. Click the Settings tab located above the chart.

The Settings tab appears in the Charts area (Figure 12).
3. In the **Name** field, optionally edit the name of the chart.

4. Optionally specify a different Load Session by clicking ![Select...](select_icon). The Select Sessions window appears. See *Specifying a Load Session* on page 22 for instructions.

5. Optionally specify agendas or measurements.
   - For a static chart, specify agendas in the Agenda Selection section. See *Selecting Agendas – Static Chart* on page 36.
   - In an interactive chart, specify measurements in the Measurement Selection section. See *Selecting Measurements – Interactive Chart* on page 37.


8. Optionally change parameter settings. See *Modifying Chart Parameters* on page 43.

---

### Selecting Agendas – Static Chart

In a static chart, you can select specific Agendas to include in your chart. The generated chart will include a separate graph and table for each Agenda. By Default, charts are generated for all the Agendas of a Load Session.
To select Agendas:

1. Select the chart in the Charts area.
2. Click the Settings tab of the chart (Figure 12).
3. Click the Agenda Selection section. The Agenda Selection area appears.

![Figure 13: Agenda Selection Area]

Note: If any changes are made to the Agenda selection, an asterisk (*) is displayed besides Agenda Selection in the section’s title.

4. Select the Agendas to include in your chart. Total is the Agenda selected by default and indicates that the chart will be generated for all the Load Session’s Agendas.

The selected Agendas are added to your chart settings. To regenerate the chart with the new settings, click [Regenerate Chart].

Selecting Measurements – Interactive Chart

In an interactive chart, you can select specific measurements from all or specific Agendas. By default, charts are generated for all the measurements of a Load Session.

To select measurements:

1. Select the chart in the Charts area.
2. Click the Settings tab of the chart (Figure 12).
3. Click the Measurement Selection section. The Measurement Selection area appears.
Figure 14: Measurement Selection Area

**Note:** If any changes are made to the measurements selection, an asterisk (*) is displayed besides Measurement Selection in the section’s title.

4. Select the measurements to include in your chart. **Total** is selected by default and indicates that the report will be generated for all the Load Session’s Agendas.

5. Select a value for the X-axis of the graph:
   - **Time** – Shows the selected measurements over time. In the Parameters section (described in *Modifying Chart Parameters* on page 43), you can edit the Time Format parameter and set it to one of the following values:
     - **Relative seconds** – Shows the selected measurements over time. The time is displayed as the number of seconds that elapsed from the beginning of the test (20, 40, 60, 80, 120, etc.).
     - **Relative time** – Shows the selected measurements over time. The time is displayed as the time that passed from the beginning of the test (00:20, 00:40, 01:00, 01:20, etc.).
     - **Absolute time** – Shows the real time, starting from the time at the beginning of the test (17:31:40, 17:32:00, 17:32:20, ...).
   - **Load Size** – Shows the change in selected measurements over the Load Size measurement. For example, if you select the 'Response Time' measurement, then Response Time over Load Size shows the response times in different load sizes, regardless of when the measurement was received.
   - **Percentile** – Shows all the percentile values of the selected measurement(s). For example, the 90th percentile means that 90% of measurements are smaller than this value, and 10% are larger than this value.
• **Summary** – Shows the sum (such as the average value) of the selected measurements.

• **Other** – Shows the selected measurement(s) over any measurement of your choice. For example, 'Response Time over Content Size' shows the variations in the response time, based on the size of the response, regardless of time/load size.

The selected measurements are added to your chart settings. To regenerate the chart with the new settings, click ![Chart Preview](chart.png).

### Filtering by Time

Reports are generated for the entire Load Session by default. Use the Time Filter to remove the beginning or end of a Load Session or focus on a specific window of Load Session time. If the template you are using does not support this filter, the Time Filter section is disabled.

**To change the Load Session time range:**

1. Select the chart in the Charts area.
2. Click the **Settings** tab of the chart (Figure 12).
3. Click the **Time Filter** section. The Time Filter appears.

![Time Filter](time_filter.png)

**Figure 15: Time Filter Area**

**Note:** If any changes are made to this filter, an asterisk (*) is displayed besides Time Filter in the section’s title.

**Note:** You can enable or disable the Time Filter by selecting or clearing the **Filter Enabled** checkbox. When this checkbox is cleared, “(Disabled)” is displayed in the Time Filter section.

4. Use the slider to change the Load Session start and end times. The number of seconds and the actual dates and times are displayed as you move the slider.

   Only the Load Session data from the time specified is used to generate the report.
To clear the Time Filter:

- In the Time Filter area (Figure 15), click [Restore default time filter]. The Time Filter defaults are restored in the From and To fields. By default, the entire duration of the Load Session is displayed.

To regenerate the chart with the new settings, click [Chart Preview].

### Filtering by Statistics-based Time

The statistics-based time filter enables you to specify a numeric filter for each of the statistics in the Load Session. This filter filters out segments of a chart based on their time. However, in contrast to the time filter, data is only filtered if it matches the specified condition. You can specify a numeric filter for multiple statistics and connect them using logical connectors, such as match all or any of the conditions. If the template you are using does not support this filter, the Statistics-based Time Filter section is disabled.

**Note:** The actual statistics are not filtered by this filter.

For example, if your Load Session contains the following statistics and you filter by Load Size being greater than or equal to five, your chart will display the last three time segments only (from 40 to 80):

<table>
<thead>
<tr>
<th>Time</th>
<th>Load Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>1</td>
</tr>
<tr>
<td>40</td>
<td>5</td>
</tr>
<tr>
<td>60</td>
<td>10</td>
</tr>
<tr>
<td>80</td>
<td>15</td>
</tr>
</tbody>
</table>

**Note:** For an explanation of the statistics and their meanings, see the *WebLOAD Console User Guide*.

**To add a filter to a specific statistic:**

1. Select the chart in the Charts area.
2. Click the Settings tab of the chart (Figure 12).

5. Select the measurement that you wish to filter from the top list.
6. In the Operator column, select an operator from the drop-down list (≤, <, =, >, or ≥).
7. Enter a value in the Value field.

**Note:** The range of values recorded during the selected Load Session for the selected measurement is displayed in the Value range field.

8. Click OK. The statistic is added to the Statistics-based Time Filter area.
9. Repeat steps 5 through 8 for each statistic that you wish to add to the filter.
10. If you added multiple statistics, select a connector (Match all conditions or Match any of the conditions) in the Statistics-based Time Filter area.

**Note:** The Match all conditions and Match any of the conditions connectors apply to all statistics. For example, defining multiple measurements connected by Match all conditions filters according to all the statistics.

To edit the statistics listed in the Statistics-based Time Filter area:

1. In the Statistics-based Time Filter area (Figure 16), double-click a statistic.
   - Or -

   Select a statistic and click **Edit**.

   The Measurement Selection for Statistics-based Time Filter window appears (Figure 17).

2. Edit the statistic as necessary and click **OK**.
   The statistic is updated.

To remove a statistic from the Statistics-based Time Filter area:

- In the Statistics-based Time Filter area (Figure 16), select a statistic and click **Remove**. The statistic is removed from the Statistics-based Time Filter area.

To clear the Statistics-based Time Filter area of all statistics:

1. In the Statistics-based Time Filter area (Figure 16), click **Clear filter**. A confirmation message appears.
2. Click **Yes** to confirm. The Statistics-based Time Filter area is cleared of all entries.

To regenerate the chart with the new settings, click **Chart Panel**.
Modifying Chart Parameters

The Chart Master template is used together with the individual template to create a chart. The master templates contain global parameters that can be modified to change your chart’s appearance, such as whether to show tables and graphs, or show only graphs.

Chart templates contain local parameters. You can change the values for these parameters in the Parameters section of the chart. This will only affect the current chart. The parameters that appear in the Parameters section can also be modified in the Preferences window, setting new default values for all templates using them. For a full list of parameters, see Defining Your Parameter Preferences on page 70.

Note: You can change the chart master template being used by specifying a different chart master template in the Analytics tab of the Preferences window. See Defining Your Analytics Preferences on page 66.

To modify your chart parameters:

1. Select the chart in the Charts area.
2. Click the Settings tab of the chart (Figure 12).
3. Click the Parameters section. A list of available parameters appears.

Note: The values displayed for the available parameters are the global values defined in the Parameters tab of the Preferences window.

4. Select a parameter and click to edit the parameters of your choice. Only parameters relevant to the selected template are displayed.

To regenerate the chart using the modified parameters, click.
Generating Reports

WebLOAD Analytics enables you to quickly and easily generate reports in various formats. A report is a concatenation of all open charts, or of a subset of your choice. You can then publish the report in various formats.

**Note:** Whether or not a title page is displayed depends on the master template in use. For more information about modifying the master template, see *Defining Your Analytics Preferences* on page 66.

Creating New Reports

A report is a compilation of all or some of the charts open in the Charts area. A prerequisite to generating a report is to create the charts you wish to include in the report.

**To generate a WebLOAD Analytics report:**

1. Select **File ➤ Generate Report** or click ![Generate Report](image).
   
   The Generate Report: Report Settings window appears, listing all open charts.
2. Specify a name for the report.

3. Select the charts to include in the generated report.

4. Optionally, change the order in which the charts will be displayed by selecting a chart and clicking **Up** or **Down**.

5. Click **Generate**.

A Preview of the report appears. You can:

- Navigate the report using the navigation bar, described in Table 3.
- Print the report (see *Printing a Report* on page 47).
- Publish the report to various formats (see *Publishing Reports* on page 47).
- Save the report to file (see *Saving Reports* on page 48).
- Modify global report parameters (see *Defining Your Preferences* on page 66).
Printing a Report

To print a WebLOAD Analytics report:

1. Open the report you wish to publish. For more information see Opening Saved Reports on page 49.
2. Click to generate a report preview.
3. In the report preview, click . The Print window opens.
4. Select the print options you require and click OK. The report is printed.

Publishing Reports

WebLOAD Analytics enables you to publish a report in the following formats:

- Doc (Microsoft Word).
- PDF (Adobe Reader).
- XLS (Excel). Note the following:
  - Summary tables (below the graph) are exported if they are displayed. To ensure that summary tables are displayed, set the `SHOW_TABLES` parameter to True in the charts you want displayed (as described in Modifying Chart Parameters on page 43).
  - To work with the data more conveniently, change the Reports master template to Raw (as described in Defining Your Analytics Preferences on page 66).
- XSL (Excel 97-2003). Note that it is preferable to use XSLX format whenever possible.
- HTML (Browser, Internet Explorer).
- RTF (Rich Text Format). Note that it is preferable to use Doc format whenever possible.

To publish a report:

1. Open the report you wish to publish. For more information see Opening Saved Reports on page 49.
2. Click to generate a report preview.
3. Click in the report preview toolbar to publish your report as the default format specified in the Preferences window,
   -Or-
   Click the adjacent arrow to select a different report format.

   The Save As window opens to the location specified in the Preferences window.

4. Select a location and name for your report and click Save. The report is published in the format chosen and saved to the location you specified.

---

## Saving Reports

When you save your report, it is saved to a default location, unless you specify a different location in the Save to field. To change the default location, see Defining Your Analytics Preferences on page 66.

**To save your report:**

1. Select File ➤ Save or click .

   If this is the first time you are saving your report, the Save As window opens. If you have already specified a location in the Save As window, your file is saved to the default save location.

   ![Save As](image)

   *Figure 20: Save As*

2. Enter the path to which you wish to save the report, or click Browse to navigate to the location.

3. Click OK. The report is saved to the specified location.
Opening Saved Reports

WebLOAD Analytics reports are by default saved to the location specified in the Analytics tab of the Preferences window. You can open a previously saved report from the Recent Reports tab, or you can retrieve your report directly from your file system. For information about changing the default location for saved reports, see *Defining Your Analytics Preferences* on page 66.

Opening Reports from the Recent Reports Tab

To open a report from the Recent Reports window:

1. Click the **Recent Reports** tab. The Recent Reports window opens.

![Figure 21: Recent Reports Window](image)

**Note:** The number of reports listed in this window is defined in the Preferences window (see *Defining Your Preferences* on page 66). By default, the 20 most recent reports are listed chronologically, with the most recent listed first.

2. Click the Name column header to toggle between the following sorting options:
   - Sort alphabetically (A-Z).
   - Sort alphabetically (Z-A).
   - Display the most recently used reports first.

3. Double-click the report you wish to open. You can simultaneously open multiple reports by holding down **Ctrl** or **Shift**, clicking the reports, and pressing **Enter**.

   The charts comprising the report are displayed in the Charts area. All previously opened charts are closed.

**Note:** To publish or print the report, you must first click ![Publish](image) to generate a report preview, and then use the publish and print options in the report preview toolbar.
Opening a Report From the File System

To open a report from the file system:

1. Select File ➤ Open Report or click .
   The Select Report File window appears.

2. Browse to the report you wish to open and click Open. Note that WebLOAD Analytics reports have a .report extension.
   The charts comprising the report are displayed in the Charts area. All previously opened charts are closed.

   **Note:** To publish or print the report, you must first click to generate a report preview, and then use the publish and print options in the report preview toolbar.

Modifying Report Appearance

The general appearance of the report is determined by the reports master template being used. You can influence the report appearance in the following ways:

- You can specify a different report master template, as described in Defining Your Analytics Preferences on page 66.
- You can change the default values of some master template parameters, as described in Defining Your Parameter Preferences on page 70.

   **Note:** The appearance of each chart in the report is determined by the reports master template, not the chart master template.
Working with Load Sessions

WebLOAD Console generates the Load Session files (.ls, .sdb, .mdb, .isd, and .dat) that contain all the results collected during the execution of a Load Test. When you import a Load Session file (.ls) for use in WebLOAD Analytics, all the other files are also imported with it. All the imported Load Session files are stored in a separate WebLOAD Analytics Load Session Repository.

WebLOAD Analytics enables you to import Load Sessions you wish to use to generate your reports, search the database for the Load Sessions you require, and delete redundant Load Sessions.

Importing Load Sessions

You can import a single or multiple Load Sessions into the WebLOAD Analytics Load Session Repository. The Load Session’s name is automatically derived from the selected .ls file’s name.

To import a Load Session:

1. Select File ➤ Import Sessions, or click . The Open window appears.

2. Browse to the Load Session (.ls file) you wish to import and click Open. The Load Session is imported and saved in the WebLOAD Analytics Load Session Repository, as defined in your Preferences. The Load Session is listed in the From Repository area of the Select Session window (Figure 5).
Notes: When you import a Load Session from WebLOAD Console into the WebLOAD Analytics Load Session Repository, the Summary Portfolio is automatically generated for the Load Session. For information about changing this default behavior, see Defining Your Analytics Preferences on page 66.

A Load Session that is currently open in WebLOAD Console cannot be imported. Unless you launch WebLOAD Analytics from within WebLOAD Console, close the Load Session before importing it. For more information about launching WebLOAD Analytics from WebLOAD Console, see Launching WebLOAD Analytics on page 16.

Searching for Load Sessions

You can search the WebLOAD Analytics Repository for Load Sessions by date, or using keywords.

Searching by Date

You can narrow your search for the Load Session you require by displaying Load Sessions that fall within a certain date range only.

To search for a range of the most recent Load Sessions:

1. Select File ➤ Select Sessions, or click . The Select Session window appears (Figure 5).
2. In the From Repository area, click and drag the slider to the right to display more recent Load Sessions. Click and drag to the left to display progressively older Load Sessions.

   By default, the slider is set to display all sessions that appear in the WebLOAD Analytics Repository. As you move the slider to the left, it displays sessions from the last year, last three months, last month, last week, last three days, and last day, respectively.

   ![Figure 22: Select Sessions – Slider](image)

   Note: You can also open the Select Session window by clicking in the Settings tab.
Searching by Session Name

You can search for the Load Session you require by specifying part of the name, or the full name, of the Load Session you require.

To search for a Load Session by session name:

1. Select File > Select Sessions, or click . The Select Session window appears (Figure 5).
2. In the Session name field, enter the Load Session name, or part of the name that you wish to find. Load Sessions matching the search name or part of the name, are displayed in the From Repository area, as you type.

Deleting Load Sessions

You can delete Load Sessions that you no longer require from the WebLOAD Analytics Load Session Repository. Deleting Load Sessions removes them from the repository. Any references to them in WebLOAD Analytics are also removed.

Note: When a Load Session is imported from WebLOAD Console, a copy of the Load Session is saved in the WebLOAD Analytics Load Session Repository. Deleting a Load Session from the WebLOAD Analytics Load Session Repository does not delete it from WebLOAD Console.

To delete a Load Session from WebLOAD Analytics:

1. Select File > Delete Sessions, or click . The Select Sessions to Delete window appears.
2. Select the Load Session or Sessions you wish to delete in the From Repository area, and click . The Load Session or Sessions are moved to the Selected Sessions area.
3. Select the Load Session(s) from the Selected Sessions area and click Delete. A warning message appears, asking if you are sure you wish to delete the selected Load Session(s).
4. Click Yes. The selected Load Session(s) are deleted from the WebLOAD Analytics Load Session Repository.
Chapter 8

Working with Templates

The Templates Gallery contains predefined templates, user-defined templates, and portfolios. WebLOAD Analytics enables you to modify and manage your templates, edit existing templates, and import new templates.

Template Overview

Chart master templates are used together with individual templates to create a chart. A chart master template contains global parameters that affect all the templates that are generated using it. You can select a default master template for charts as described in Defining Your Analytics Preferences on page 66.

Templates specify the design of a chart, including the visual layout, chart elements, and the way the data is structured. For example, depending on the master template, a template produces a chart with or without tables.

Templates can include the following elements:

- **Images** – These include the logos, images, and icons that create the chart template’s look and feel. WebLOAD Analytics provides WebLOAD logos and images by default. You can customize your templates to display your own logos and images.

- **Tables** – The Load Session data can be represented in tabular format in a chart. At least one table exists in all charts, by default. You can exclude tables from your chart by setting the SHOW_TABLES parameter to False. For more information about modifying parameters, see Defining Your Parameter Preferences on page 70.

- **Graphs** – The Load Session data can be represented in graphical format in a chart. At least one graph exists in almost all charts, by default. You can include only graphs in your chart (excluding tables) by setting the SHOW_TABLES parameter to False. For more information about modifying parameters, see Defining Your Parameter Preferences on page 70.

For more information about the WebLOAD Analytics template file structure, including storage of templates, images, and files, see WebLOAD Analytics File System Structure on page 77.
You can define a variety of additional characteristics within the chart, using local and global parameters (in the chart and in the chart master template). For example, you can specify the number of results listed in a chart, customize the look and feel of your chart, and define a threshold value for selected templates.

For more information about template preferences, see *Defining Your Preferences* on page 66.

## Creating User-defined Templates

You can change the settings of a template and then save it as a new template. This enables you to customize both static and interactive templates.

Only changes to the following settings enable you to create a new template:

- Measurements settings in the Measurement Selection area of an interactive chart.

  *Note:* Changes in the Agenda Selection area of a static chart do not enable you to save the template as a new one.

- Filtering settings in the Statistics-based Time Filter area.

- Parameter settings in the Parameters area.

**To create a user-defined template:**

1. In the Charts area, select a chart.
2. Select the Settings tab.
3. Modify the settings of the chart.
4. Select *File* ➔ *Save Chart As Template*. The Save As Template window appears.

![Figure 23: Save As Template](image)

5. Select a name and category for your template, or overwrite the existing template and click *OK*.

Your user-defined template is created and appears in the Templates Gallery in the location you specified.
Creating an Interactive Template from the Blank Template

You can create a custom interactive template based on the Blank Template. Although you can modify any template to create your own custom template (as described in Creating User-defined Templates on page 55), the Blank Template is unique in that its Measurement Selection area is empty.

To create an interactive template based on the Blank Template:

1. In the Navigation area, click the Gallery tab. The Templates Gallery appears.

![Templates Gallery](image)

Figure 24: Templates Gallery

2. Select User Defined ▶ Blank Template. The Settings tab of the Blank Template opens in the Charts area, with the Measurement Selection section displayed (Figure 14).

3. Edit the Settings of the template as desired. See Changing Chart Settings on page 35. Note that you must specify at least one measurement (see Figure 14) in order to create a template.

4. Select a value for the X-Axis of the graph and continue defining the chart template options as described in Creating User-defined Templates on page 55.

5. Select File ▶ Save Chart As Template. The Save As Template window opens.
6. Select a name and category for your template or overwrite the existing template and click OK.

Your custom interactive template is created and appears in the Templates Gallery.

---

**Creating an Interactive Regression Template from the Blank Regression Template**

You can create a custom interactive regression template based on the Blank Regression Template. Although you can modify any regression template to create your own custom regression template, the Blank Regression Template is unique in that it is interactive.

**To create a regression template based on the Blank Regression Template:**

1. In the Navigation area, click the Gallery tab. The Templates Gallery appears.
2. Select User Defined ➔ Blank Regression Template. The Select Sessions window appears (Figure 6).

3. Optionally browse to the location of a Load Session file in the From File area, and click Open.

   The Load Session file appears in the From Repository area.

4. Optionally search for Load Sessions (see Searching for Load Sessions on page 52).

5. In the From Repository area, select a Load Session you wish to use, and click Add.

    The Load Session moves to the Selected Sessions area. Repeat this step to include all the Load Sessions you wish to compare.

   The first session you select is set as the main Load Session. The main session appears in red. The main session is the session to which all other Load Sessions are compared.

6. To specify a different session as the main session, select the Load Session in the Selected Sessions area and click Set as main.

7. Edit the Settings of the template as desired (see Changing Chart Settings on page 35). Note that you must specify at least one measurement (see Figure 14) in order to create a template.

8. Select a value for the X-Axis of the graph and continue defining the chart template options as described in Creating User-defined Templates on page 55.

9. Select File ➔ Save Chart As Template. The Save As Template window opens.
Figure 27: Save As Template

10. Select a name and category for your template or overwrite the existing template and click OK.

Your custom interactive regression template is created and appears in the Templates Gallery.

Managing Template Categories

You can manage template categories in various ways:

- Group your templates into different categories by creating your own categories and moving templates into them.
- Rename the categories to create logical groups for your templates.
- Copy or move templates from one category to another, and rename templates.

Creating New Template Categories

You can create new categories, to enable easy categorization of your templates.

To create a new template category:

1. In the Navigation area, click the Gallery tab. The Templates Gallery opens (Figure 9).
2. Right-click in the Templates Gallery and select New Category from the menu. The New Category window opens.

Figure 28: New Category
3. Enter a name for your new category, and click OK. The new category is listed in the Templates Gallery, which is ordered alphabetically. You can now move the templates you require into the new category.

**Copying Templates**

WebLOAD Analytics enables you to copy templates from one template category to another.

**To copy a template to a new location:**

1. In the Navigation area, click the **Gallery** tab. The Templates Gallery appears (Figure 9).
2. Select the template you wish to copy.
   Right-click in the Templates Gallery and select **Copy** from the menu.
3. Click the destination category.
4. Right-click in the Templates Gallery and select **Paste** from the menu. A copy of the template appears under the selected category.

**Note:** To move a template, drag-and-drop the template from one category to another.

**Renaming Templates and Template Categories**

You can easily rename a template or template category. This enables you to create logical groups to categorize and group your templates.

**To rename a template or template category:**

1. In the Navigation area, click the **Gallery** tab. The Templates Gallery appears (Figure 9).
2. Select the template or template category you wish to rename.
3. Right-click the template or template category, and select **Rename** from the menu.
4. Enter the new name in the Enter a new name field, and click **OK**. The template or template category is renamed.
Deleting Templates and Template Categories

To delete a template or template category:

1. In the Navigation area, click the Gallery tab. The Templates Gallery appears (Figure 9).
2. Select the template or template category that you wish to delete.
   Right-click in the Templates Gallery and select Delete from the menu.
   A confirmation message appears.
3. Click Yes to delete the template or template category.

Note: When deleting a template category, all the templates contained within the category are also deleted.

Using JasperSoft iReport

Since you can use interactive reports to create your own reports on any measurement set, you would typically not need to change the supplied static templates. However, you can change a static template if you wish. JasperSoft iReport enables you to create new templates or modify existing templates for use with WebLOAD Analytics. JasperSoft iReport provides a range of functions for the creation and customization of templates. WebLOAD Analytics supports version 2.0.4 of JasperSoft iReport.

Note: If the path to JasperSoft iReport has been defined in your WebLOAD Preferences, you can launch JasperSoft iReport directly from WebLOAD Analytics.

To launch JasperSoft iReport from WebLOAD Analytics:

1. In the Navigation area, click the Gallery tab. The Templates Gallery opens (Figure 9).
2. Select the template that you wish to edit. Right-click in the Templates Gallery and select Edit with iReport. The JasperSoft iReport application opens.

Note: You can use any JRXML-compatible tool to create or modify templates. RadView does not provide support for JasperSoft iReport, or other third party tools used to create or modify templates.

For further information about the use of JasperSoft iReport, see the following Web pages:

Importing New Templates

WebLOAD Analytics enables you to import templates created or edited in JasperSoft iReport, or any JRXML-compatible tool. WebLOAD Analytics supports version 2.0.4 of JasperSoft iReport.

**Note:** RadView does not provide support for JasperSoft iReport, or other third party tools used to create or modify templates.

To import a new template:

1. In the Navigation area, click the **Gallery** tab. The Templates Gallery appears (Figure 9).
   Right-click in the Templates Gallery and select **Import Template**. The Import Template window opens.
   
   ![Image of Import Template window](image)
   
   *Figure 30: Import Template*

2. Enter the template parameters, according to the information in Table 6:

<table>
<thead>
<tr>
<th>Template Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source template folder</td>
<td>The path to the template JRXML file that you wish to import. Enter the path to the template, or click <strong>Browse</strong> to navigate to the JRXML file location.</td>
</tr>
<tr>
<td>Template name</td>
<td>The name of the template,</td>
</tr>
<tr>
<td>Destination category</td>
<td>A drop-down list of the template categories available in WebLOAD Analytics.</td>
</tr>
</tbody>
</table>

3. Click **OK**. The template is listed in the Gallery tab, under the selected folder.

**Note:** If no template categories are defined when importing a template, the Source Template Folder field is replaced with the Create Folder field. Define a folder name before importing your template.
Working with Portfolios

WebLOAD Analytics enables you to create a portfolio of templates that you can open in a single action. Use portfolios to group together commonly used templates to speed up your work.

Note: Generating, printing, and publishing individual charts within a portfolio or entire portfolios is identical to generating, printing, and publishing charts. For more information, see Generating Charts on page 21.

Creating a Portfolio

When you create a new portfolio, you assign the templates you wish to include by dragging them into your portfolio in the Templates Gallery tree. The assigned templates appear as links within the portfolio.

Note: If a template is deleted from the Templates Gallery and the portfolio links associated with it are not deleted, unresolved template links appear in the tree marked with a red x. When publishing the portfolio, templates with unresolved links are not published.

To create a portfolio:

1. In the Navigation area, click the Gallery tab. The Templates Gallery opens (Figure 9).
2. In the Templates Gallery Right-click in the Templates Gallery and select New Portfolio.
   The New Portfolio window opens.
3. Enter a name for the portfolio and click OK. The new portfolio appears under the Portfolios folder in the Templates Gallery tree.

4. In the Templates Galley, drag-and-drop the templates you want to include in your portfolio.

   Your portfolio is created.

   **Note:** To remove a template from your portfolio, select the template link from the Templates Gallery tree and click **Delete**. Removing a template link from your portfolio does not delete it from the Templates Gallery.

---

### Opening a Portfolio

**To open a portfolio:**

1. In the Templates Gallery, open the Portfolios node.

2. Double-click the portfolio you wish to open.

   The charts created by the portfolio open in the Charts area (Figure 32).

   **Note:** Any charts that were already open in the Charts area remain open.

   You can now generate, print, or publish a report based on the open charts. For more information, see

   - *Creating New Reports* on page 45.
   - *Printing a Report* on page 47.
   - *Publishing Reports* on page 47.
To rename a portfolio:

1. In the Navigation area, click the **Gallery** tab. The Templates Gallery opens (Figure 9).

2. Right-click a portfolio and select **Rename**. The Rename window appears.

Enter the new portfolio name and click **OK**. The portfolio is renamed.

**Figure 32: Opening a Portfolio**
You can define your default preferences for the following:

- **Analytics Preferences** – General display and file location preferences (see Defining Your Analytics Preferences on page 66).

- **Database Preferences** – Preferences related to the WebLOAD Analytics PostgreSQL Load Session Repository (see Defining Your Database Preferences on page 69).

- **Parameters Preferences** – Customize your template parameters globally (see Defining Your Parameter Preferences on page 70).

### Defining Your Analytics Preferences

WebLOAD enables you to define default Analytics parameters relating to saving and storing templates, reports, and log files. You can define the number of recently used reports and recently used sessions available to view in WebLOAD Analytics. You can also specify a path to Jasper iReport to enable you to access it directly from WebLOAD Analytics.
To define the Analytics preferences:

1. Select **Window > Preferences**. The Preferences window opens, displaying the Analytics preferences by default.

![Preferences Window – Analytics](image)

Figure 33: Preferences Window – Analytics

2. Edit the Analytics preferences, according to the information in the following table:

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gallery Path</td>
<td>The default location in which your templates and template categories are stored. Edit the path, or click <strong>Browse</strong> to specify a different default location.</td>
</tr>
<tr>
<td>Reports location</td>
<td>The default location to which your WebLOAD reports are saved. Edit the path, or click <strong>Browse</strong>, to specify a different default location.</td>
</tr>
<tr>
<td>Log zip location</td>
<td>The default location to which zipped log files are saved. Edit the path, or click <strong>Browse</strong> to specify a different default location.</td>
</tr>
<tr>
<td>iReport path</td>
<td>The location of the JasperSoft iReport.exe application file. Use this field to enable editing templates in JasperSoft iReport or launch JasperSoft iReport directly from WebLOAD Analytics. This option is only applicable if you have JasperSoft iReport installed on your machine (see Using JasperSoft iReport on page 61).</td>
</tr>
<tr>
<td>Preference</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Published reports location</td>
<td>The default location to which your WebLOAD reports are published. Edit the path, or click Browse, to specify a different default location.</td>
</tr>
<tr>
<td>Chart Preview master template</td>
<td>The master template that WebLOAD uses for your charts. The following master templates are available:</td>
</tr>
<tr>
<td></td>
<td>• Raw – Displays only the actual data (table/graph). The title page, opening page, background, footers, and so on, are not included in the report.</td>
</tr>
<tr>
<td></td>
<td>• WebLOAD – In addition to displaying the actual data, displays also a title page, and footers/headers with page numbers, logos, etc.</td>
</tr>
<tr>
<td></td>
<td>• WebLOAD with background – In addition to the items displayed in the WebLOAD master template, displays also a background image.</td>
</tr>
<tr>
<td>Reports master template</td>
<td>The master template that WebLOAD uses for your reports. The same master templates available for Charts are available for Reports (Raw, WebLOAD, WebLOAD with background).</td>
</tr>
<tr>
<td>Default portfolio to be automatically generated for imported sessions</td>
<td>The portfolio that WebLOAD Analytics automatically generates when you import a Load Session. The default portfolio is the Summary portfolio. Select None to disable this function.</td>
</tr>
<tr>
<td>Number of reports shown in recent reports</td>
<td>The number of recently used reports you want to display in the Recent Reports tab.</td>
</tr>
<tr>
<td>Default output format for published reports</td>
<td>The default format in which your reports are published. Select the format you want your reports to be published in by default from the options listed.</td>
</tr>
<tr>
<td>Logger severity settings</td>
<td>The minimum severity level of errors that are logged. Used for support purposes only.</td>
</tr>
<tr>
<td>Launch external viewer after publishing report</td>
<td>Select this option to open a published report in its native application immediately after publishing. When this option is not selected, the published report is not opened.</td>
</tr>
</tbody>
</table>

3. Click **OK** to save changes,
   -Or-

   Click **Restore Defaults** to restore preferences to the factory default settings.
Defining Your Database Preferences

WebLOAD Analytics enables you to define default parameters relating to the WebLOAD Analytics Load Session Repository, including username and password details. In order to connect to a remote database, additional configuration for that remote database may be necessary (for more information, see the WebLOAD Installation Guide).

To define your database preferences:

1. Select **Window > Preferences**. The Preferences window opens displaying the Analytics preferences by default (Figure 33).

2. Click **Database**,
   - Or-

   Type **Database** in the type filter text field, and press **Enter**. The Database preferences are displayed.

   ![Figure 34: Preferences Window – Database](image)
3. Edit the Database preferences, according to the information in the following table:

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database host name</td>
<td>The host on which the database is located.</td>
</tr>
<tr>
<td>Database port</td>
<td>The port used to access the database.</td>
</tr>
<tr>
<td>Database name</td>
<td>The name of the database.</td>
</tr>
<tr>
<td>User name</td>
<td>The database user name.</td>
</tr>
<tr>
<td></td>
<td>The user name is defined during installation.</td>
</tr>
<tr>
<td>User password</td>
<td>The database password.</td>
</tr>
<tr>
<td></td>
<td>The password is defined during installation.</td>
</tr>
</tbody>
</table>

4. Click **OK** to save changes,
   - Or -
   Click **Restore Defaults** to restore preferences to the factory default settings.

---

**Defining Your Parameter Preferences**

The Preferences window enables you to define default parameters relating to the charts and reports you produce using WebLOAD Analytics.

Parameters can be applied locally to individual charts, or globally to all charts and reports. If the same parameter is defined locally, the local parameter overrides the global parameter.

For information about applying parameter preferences locally, to individual templates, see *Modifying Chart Parameters* on page 43.

**To display the global parameter preferences:**

1. Select **Window ➤ Preferences**. The Preferences window opens displaying the Analytics preferences by default (Figure 33).
2. Click **Parameter**,
   - Or -
   Type **Parameter** in the type filter text field and press **Enter**. The Parameters preferences are displayed.
Figure 35: Preferences Window – Parameters
Table 9 provides a description of the default parameters and their functions.

### Table 9: Preferences Parameters Fields

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Valid Values</th>
<th>Applicable Templates</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXES_SCALE</td>
<td>Controls how measurements are spread over the Y-axes.</td>
<td>Specify one of the following:</td>
<td>All interactive templates.</td>
</tr>
<tr>
<td></td>
<td>• Separate Y-Axes – each measurement is shown on its own axis.</td>
<td>• Separate Y-Axes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Single Y-Axis – all measurements are shown on a single axis, using a single scale. Values that are an order of magnitude smaller may appear as zero.</td>
<td>• Single Y-Axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Consolidate Y-Axes by type – show measurements of the same type/unit on the same axis and scale.</td>
<td>• Consolidate Y-Axes by type (default value)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Auto scale to single Y-Axis – show all measurements on a single, 0-100 scaled axis. Each measurement is scaled accordingly.</td>
<td>• Auto scale to single Y-Axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Show only trends – show all measurements without scale. The actual values cannot be understood from the graph. This option is used to compare trends.</td>
<td>• Show only trends</td>
<td></td>
</tr>
<tr>
<td>COMMENTS</td>
<td>Any additional comments, displayed under the Additional Comments heading on the opening page.</td>
<td>Enter the text you wish to display.</td>
<td>General Session Information</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>All interactive templates</td>
</tr>
<tr>
<td>CONTINUOUS_LINE</td>
<td>Defines whether to draw the chart line as a continuous line, bridging over missing data points. Set to True when data points are likely to be missing (such as in a Transactions Over Time charts).</td>
<td>Select True or False.</td>
<td>All interactive templates</td>
</tr>
<tr>
<td>FOOTERLOGO</td>
<td>The logo or image that you wish to display in the footer.</td>
<td>Enter the path to the image that you wish to use, in the format: \pathname</td>
<td>Master templates</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Valid Values</td>
<td>Applicable Templates</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>FOOTERTEXT</td>
<td>The text that you wish to display in the footer of the page.</td>
<td>Enter the text you wish to display.</td>
<td>Master templates</td>
</tr>
<tr>
<td>HEADERLOGO</td>
<td>The logo or image that you wish to display in the header.</td>
<td>Enter the path to the image that you wish to use, in the format: \pathname</td>
<td>Master templates</td>
</tr>
<tr>
<td>HEADERTEXT</td>
<td>The text that you wish to display in the header of the page.</td>
<td>Enter the text you wish to display.</td>
<td>Master templates</td>
</tr>
<tr>
<td>MAX_Y_AXES</td>
<td>Determines the maximum number of Y-axes to show. If the number of Y-axes in</td>
<td>Enter a numerical value (Default = 6).</td>
<td>All interactive templates.</td>
</tr>
<tr>
<td></td>
<td>your report is greater than this value, the Y-axes are consolidated to a</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>single axis (similar to AXES_SCALE = Auto scale to single Y-Axis).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MIN_SEVERITY</td>
<td>The minimum log severity level to show. The levels are:</td>
<td>Enter a numerical value from 1 – 4.</td>
<td>Errors By Severity</td>
</tr>
<tr>
<td></td>
<td>1 – Info</td>
<td></td>
<td>Error Per Second</td>
</tr>
<tr>
<td></td>
<td>2 – Minor error</td>
<td></td>
<td>Log Messages</td>
</tr>
<tr>
<td></td>
<td>3 – Error</td>
<td></td>
<td>Log Summary</td>
</tr>
<tr>
<td></td>
<td>4 – Severe error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPEN_COMPANY</td>
<td>The company name that you wish to display on the opening page.</td>
<td>Enter the text you wish to display.</td>
<td>General Session Information</td>
</tr>
<tr>
<td>OPEN_REPORTER_NAME</td>
<td>The name of the person creating the chart, displayed on the opening page.</td>
<td>Enter the text you wish to display.</td>
<td>General Session Information</td>
</tr>
<tr>
<td>OPEN_REPORTER_TITLE</td>
<td>The title of the person creating the chart, displayed on the opening page.</td>
<td>Enter the text you wish to display.</td>
<td>General Session Information</td>
</tr>
<tr>
<td>OPEN_SUT_DIAGRAM</td>
<td>A schematic diagram of the SUT to which the chart refers, displayed on</td>
<td>Enter the path to the image that you wish to use, in the format: \pathname</td>
<td>General Session Information</td>
</tr>
<tr>
<td></td>
<td>the opening page.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPEN_SUT_NAME</td>
<td>The name of the System Under Test (SUT) to which the chart refers, displayed on the opening page.</td>
<td>Enter the text you wish to display.</td>
<td>General Session Information</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Valid Values</td>
<td>Applicable Templates</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>OPEN_SUT_VERSION</td>
<td>The version of the SUT to which the chart refers, displayed on the opening page.</td>
<td>Enter the text you wish to display.</td>
<td>General Session Information</td>
</tr>
<tr>
<td>PERCENTILE</td>
<td>Defines a value below which X percent of the observations fall.</td>
<td>Enter the percentage of results you wish to display (Default = 90).</td>
<td>Failed Transactions Slowest Transaction Transactions Summary</td>
</tr>
<tr>
<td></td>
<td>For example, the 20th percentile is the value below which 20 percent of the observations may be found. In other words, a test score that is greater than 85 percent of the scores of people taking the test is referred to as being at the 85th percentile.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SHOW_TABLES</td>
<td>Defines whether to show tables and graphs, or show only graphs.</td>
<td>Select True or False.</td>
<td>All</td>
</tr>
<tr>
<td>SUBTITLE</td>
<td>The subtitle that you wish to display in the title page.</td>
<td>Enter the text you wish to display.</td>
<td>Master templates</td>
</tr>
<tr>
<td>THRESHOLD_TOLERANCE</td>
<td>Defines a tolerance range, above the threshold value. Results in the chart table that fall within the threshold tolerance range are displayed in yellow. On line graphs, a line representing the tolerance threshold is displayed.</td>
<td>Enter a numerical value above the threshold value, to define the range (Default = 0).</td>
<td>Regression templates All interactive templates</td>
</tr>
<tr>
<td>THRESHOLD</td>
<td>Defines a threshold value above which results are highlighted in your chart. Results exceeding the threshold value are displayed in red. On line graphs, a line representing the tolerance value is displayed.</td>
<td>Enter a numerical threshold value (Default = 0).</td>
<td>Regression templates All interactive templates</td>
</tr>
<tr>
<td>TIME_FILTER_FROM_BEGINNING</td>
<td>Defines the number of seconds to trim from the beginning of a session, by default. This is useful if there is often a lot of noise at the beginning of a session</td>
<td>Enter a numerical value (Default = 0)</td>
<td>All templates with a time filter</td>
</tr>
<tr>
<td>TIME_FILTER_FROM_END</td>
<td>Defines the number of seconds to trim from the end of a session, by default. This is useful if there is often a lot of noise at the end of a session</td>
<td>Enter a numerical value (Default = 0).</td>
<td>All templates with a time filter</td>
</tr>
</tbody>
</table>

Chapter 10. WebLOAD Analytics File System Structure
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Valid Values</th>
<th>Applicable Templates</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIME_FORMAT</td>
<td>The time format to use when the X-axis represents time.</td>
<td>Specify one of the following:</td>
<td>All interactive templates. Relevant when the X-axis represents time.</td>
</tr>
<tr>
<td></td>
<td>Relative Time – shows the time that elapsed since session start time.</td>
<td>• Relative Time (default value)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Absolute Time – shows the full time.</td>
<td>• Absolute Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Absolute Date – shows the full date and time.</td>
<td>• Absolute Date</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Relative Seconds – shows the number of seconds that elapsed since session</td>
<td>• Relative Seconds</td>
<td></td>
</tr>
<tr>
<td></td>
<td>start time.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOP_RESULTS</td>
<td>The default number of displayed measurements, starting from the first</td>
<td>Enter a numerical value (Default = 0)</td>
<td>All interactive templates</td>
</tr>
<tr>
<td></td>
<td>measurement in the list.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The number zero (0) indicates all specified measurements.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TRAN_PERCENT</td>
<td>Defines the percentage of transactions you wish to display in a chart.</td>
<td>Enter a numerical value (Default = 100).</td>
<td>Slowest Transactions</td>
</tr>
<tr>
<td></td>
<td>This parameter takes precedence over the TRAN_QTY parameter.</td>
<td></td>
<td>Transactions with Most Failures</td>
</tr>
<tr>
<td>TRAN_QTY</td>
<td>Defines the number of transactions you wish to display in a chart.</td>
<td>Enter a numerical value (Default = 10).</td>
<td>Slowest Transactions</td>
</tr>
<tr>
<td></td>
<td>This parameter is relevant if the TRAN_PERCENT parameter is zero (0).</td>
<td></td>
<td>Transactions with Most Failures</td>
</tr>
</tbody>
</table>

To apply a parameter to your charts or reports globally:

1. From the parameters displayed in the Preferences window (Figure 35), select the parameter you wish to edit and click **Edit**. The Edit Parameter window appears.
2. Edit the relevant fields and click **OK**. The parameters table is updated to reflect your changes. The parameter is applied each time you create a new chart or report.

To add a new parameter to the parameters list:

1. In the Parameters tab of the Preferences window (Figure 35), click **Add**. The Add Parameter window appears.
2. Enter information for the new parameter, according to the following table:

Table 10: Add Parameter Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter Name</td>
<td>The name of the parameter.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The name that is displayed in the template parameters list.</td>
</tr>
<tr>
<td>Parameter Type</td>
<td>The type of parameter:</td>
</tr>
<tr>
<td></td>
<td>• String</td>
</tr>
<tr>
<td></td>
<td>• Integer</td>
</tr>
<tr>
<td></td>
<td>• Double</td>
</tr>
<tr>
<td></td>
<td>• Positive Integer</td>
</tr>
<tr>
<td></td>
<td>• Positive Double</td>
</tr>
<tr>
<td>Parameter Value</td>
<td>The value of the parameter.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the function of the parameter.</td>
</tr>
</tbody>
</table>

3. Click OK. The parameter is added to the parameters list and the change is applied to the Templates Gallery.

To remove a parameter from the parameters list:

- From the list of parameters displayed in the Preferences window (Figure 33), select the parameter you wish to remove and click Remove. The parameter is removed from the list.

Note: RadView recommends that you do not remove any parameters. To restore the default list of parameters, click Restore Defaults. When selecting Restore Default, all existing parameters and their associated values are restored to their default settings.
Appendix A

WebLOAD Analytics File System Structure

WebLOAD Analytics File Structure

The WebLOAD Analytics file structure consists of system files, database files, log files, and files containing templates and template elements. The table below describes the WebLOAD file structure and its contents. The folders listed in the table below are located in the `<WebLOAD directory>\bin` folder.

Table 11: WebLOAD File Structure

<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>This folder is a WebLOAD Analytics system folder.</td>
</tr>
<tr>
<td></td>
<td>This folder should only be modified by qualified RadView technicians.</td>
</tr>
<tr>
<td>Database</td>
<td>This folder contains the batch files required for the installation and deployment of the WebLOAD Analytics Load Session Repository.</td>
</tr>
<tr>
<td>Gallery</td>
<td>This folder contains all WebLOAD Analytics templates. Each template has its own folder containing a template JRXML file and a Jasper file. Each template category contains the Subreports subdirectory.</td>
</tr>
<tr>
<td>Gallery[Category]</td>
<td>A Category folder can be a group of templates, such as Pages Analysis or any one of the following special categories:</td>
</tr>
<tr>
<td></td>
<td>• Portfolios.</td>
</tr>
<tr>
<td></td>
<td>• _Master Templates.</td>
</tr>
<tr>
<td></td>
<td>• _System Templates.</td>
</tr>
</tbody>
</table>
### Folder Description

<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gallery[Category][Template]</td>
<td>A Template folder exists for every template in WebLOAD Analytics, such as Load Size Summary or HTTP Responses. A template consists of the following files:</td>
</tr>
<tr>
<td></td>
<td>• .jasper – JasperReports compiled report. Generated automatically from .jrxml</td>
</tr>
<tr>
<td></td>
<td>• .system.xml – Defines a system defined interactive report.</td>
</tr>
<tr>
<td></td>
<td>• .user.xml – Stores user defined settings, when using Save Chart As Template.</td>
</tr>
<tr>
<td></td>
<td>• systemChart.xml – Stores graph configuration (such as colors, line types, etc.)</td>
</tr>
<tr>
<td></td>
<td>• userChart.xml – Stores user graph configuration.</td>
</tr>
<tr>
<td>Gallery[Category][Template]\SUBREPORTS</td>
<td>Some static Template folders contain additional .jrxml subreports in this folder, and their compiled .jasper files.</td>
</tr>
<tr>
<td>Gallery[Category][Template]\Resources</td>
<td>Some Template folders contain this folder, which contains the static graphical elements used by the template, including icons, images, and logos.</td>
</tr>
<tr>
<td>Gallery\Portfolio</td>
<td>This category contains all the [Portfolio] folders.</td>
</tr>
<tr>
<td>Gallery\Portfolio[Portfolio]</td>
<td>A Portfolio folder exists for every portfolio in WebLOAD Analytics, such as Summary Report and Extended Summary Report. This folder contains a .portfolio file, which is an XML file specifying the templates included in the portfolio.</td>
</tr>
<tr>
<td>Gallery_Master Templates</td>
<td>This category is intended for advanced users and cannot be accessed from WebLOAD Analytics. The category contains the master templates used by charts and reports. The master template of a report defines the report appearance. The master template of a chart is used in conjunction with the template to define the appearance of the chart. RadView recommends that only advanced users should modify these templates. When you add a master template, it is available for selection in the Preferences window (for more information, see Defining Your Analytics Preferences on page 66).</td>
</tr>
<tr>
<td>Folder</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Gallery_System Templates</td>
<td>This category is intended for advanced users and cannot be accessed from WebLOAD Analytics. The category contains system templates that are references by other templates. For example, all reports that are based on interactive reports reference a template in this directory.</td>
</tr>
<tr>
<td>Plugins</td>
<td>This folder is a WebLOAD Analytics system folder. This folder should only be modified by qualified RadView technicians.</td>
</tr>
<tr>
<td>Workspace</td>
<td>This folder is created the first time that WebLOAD Analytics is opened. It contains internal state persistence information.</td>
</tr>
</tbody>
</table>
Statistical Terms

The following table lists general terms used for the statistics.

Table 12: Statistical Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentile</td>
<td>A <strong>percentile</strong> is the value of a variable below which a certain percent of observations fall. Thus the 30th percentile is the value (or score) below which 30 percent of the observations may be found.</td>
</tr>
<tr>
<td>Average</td>
<td>The <strong>arithmetic mean</strong>. For timers, average is the total amount of time counted by the timer (not the elapsed time) divided by the Count (that is, the total number of readings). For example, the average for Transaction Time is the amount of time it took to complete all the successful transactions divided by the number of successful transactions (the Count).</td>
</tr>
<tr>
<td>Standard deviation</td>
<td>The <strong>standard deviation</strong> is a simple measure of the variability or dispersion of a data set. A low standard deviation indicates that all of the data points are very close to the same value (the mean). A high standard deviation indicates that the data is “spread out” over a large range of values.</td>
</tr>
</tbody>
</table>
Running Analytics in Command Line Mode

WebLOAD Analytics can be executed in command line mode. This enables incorporating WebLOAD Analytics in scripts. Two executables are available:

- WLAnalyticsCMD.exe – Automatically generates a report for a specified session, and publishes or prints it. WebLOAD Analytics then closes.
- WLAnalytics.exe – Launches the WebLOAD Analytics UI, and generates a report for a specified session.

The executables are located in `<Installation dir>\bin`. For example: C:\Program Files\RadView\WebLOAD\bin.

Running WLAnalyticsCMD.exe

Use this executable to generate a report for a specified session, and publish or print it.

**Syntax**

```
WLAnalyticsCmd.exe -m U|P {-t template_path}|-p portfolio_path} {-s session_name}\1{-ls session_path} [-f DOC|ODT|HTML|XLS|RTF|PDF] [-l report_location] [-n output_report_name] [-h]
```

**Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>-m</td>
<td>Indicates the action. Specify one of the following U – Publish. P – Print.</td>
<td>Mandatory parameter.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>-t template_path</td>
<td>Generates a chart from a specified template. You must specify the path to the template directory (either absolute or relative to the gallery).</td>
<td>You must specify one of the two options: -t or -p.</td>
</tr>
<tr>
<td>-p portfolio_path</td>
<td>Generates a report from a portfolio. You must specify the path to the portfolio directory (either absolute or relative to the Portfolio category).</td>
<td>You must specify one of the two options: -p or -t.</td>
</tr>
<tr>
<td>-s session_name</td>
<td>Specifies a session already loaded into WebLOAD. You must specify the session name. Note: You can use this parameter multiple times to specify multiple sessions. This is necessary if you are generating a regression chart.</td>
<td>You must specify one of the two options: -s or -ls.</td>
</tr>
<tr>
<td>-ls session_path</td>
<td>Specifies a load session file to import into WebLOAD. You must specify the full path. Note: You can use this parameter multiple times to load multiple sessions. This is necessary if you are generating a regression chart.</td>
<td>You must specify one of the two options: -s or -ls.</td>
</tr>
<tr>
<td>-f</td>
<td>Specifies the output format for a published report. Select one of the following: DOC, ODT, HTML, XLS, RTF, or PDF. If you do not specify an output format, the default format, specified in Analytics Preferences, is used.</td>
<td>Optional parameter.</td>
</tr>
<tr>
<td>-l report_location</td>
<td>Specifies the location of the published report. If you do not specify a location, the default location, specified in Analytics Preferences, is used.</td>
<td>Optional parameter.</td>
</tr>
<tr>
<td>-n output_report_name</td>
<td>Specifies a name for the newly created report. If you do not specify a name, the application provides a default name.</td>
<td>Optional parameter.</td>
</tr>
<tr>
<td>-h</td>
<td>Displays the help.</td>
<td>Optional parameter.</td>
</tr>
</tbody>
</table>

**Note:** Note that you must specify:
- Publish or print.
- A template or portfolio.
- A session, either previously loaded or to be imported.
Examples

To load the mysession.ls Load Session, generate a ‘General/Load Size Summary’ chart, and publish it in the default file format, in the default location, under the name test-report:

WLAnalyticsCmd.exe -m U -t "General\Load Size Summary" -ls "C:\mysession.ls" -n "test-report"

To use the loaded first-session Load Session, generate a ‘Summary Portfolio’ portfolio, and print it:

WLAnalyticsCmd.exe -m P -p "Summary Portfolio" -s “first-session”

To use the loaded first-session and second-session Load Sessions, generate a ‘Regression/Load Size Summary’ regression chart, and publish it as a PDF file in C:\myreports, using a default name:

WLAnalyticsCmd.exe -m U -t "Regression\Load Size Summary" -s “first-session” -s "second-session" -f PDF -l "c:\myreports"

Running WLAnalytics.exe

Use this executable to open the WebLOAD Analytics UI, and open a report or generate a report for a specified session.

Syntax

WLAnalytics.exe {-t template_path}|- {p portfolio_path}
{-s session_name}|-{ls session_path} [-h] [-noSplash]
## Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>(-t) template_path</td>
<td>Generates a chart from a specified template. You must specify the path to the template directory (either absolute or relative to the gallery).</td>
<td>You must specify one of the two options: (-t) or (-p).</td>
</tr>
<tr>
<td>(-p) portfolio_path</td>
<td>Generates a report from a portfolio. You must specify the path to the portfolio directory (either absolute or relative to the Portfolio category).</td>
<td></td>
</tr>
<tr>
<td>(-s) session_name</td>
<td>Specifies a session already loaded into WebLOAD. You must specify the session name. Note: You can use this parameter multiple times to specify multiple sessions. This is necessary if you are generating a regression chart.</td>
<td>You must specify one of the two options: (-s) or (-ls).</td>
</tr>
<tr>
<td>(-ls) session_path</td>
<td>Specifies a load session file to import into WebLOAD. You must specify the full path. Note: You can use this parameter multiple times to load multiple sessions. This is necessary if you are generating a regression chart.</td>
<td></td>
</tr>
<tr>
<td>(-h)</td>
<td>Displays the help.</td>
<td>Optional parameter.</td>
</tr>
<tr>
<td>(-noSplash)</td>
<td>Launches without a Splash screen.</td>
<td>Optional parameter.</td>
</tr>
</tbody>
</table>

**Note:** Note that you must specify:
- A template, report, or portfolio.
- A session, either previously loaded or to be imported.

## Examples

To open the WebLOAD Analytics UI, load the `mysession.ls` Load Session, and generate a ‘General/Load Size Summary’ chart:

```
WLAnalytics.exe -t "General\Load Size Summary" -ls "C:\mysession.ls"
```

To open the WebLOAD Analytics UI, use the loaded `first-session` Load Session, and generate a ‘Summary Portfolio’ portfolio:

```
WLAnalytics.exe -p "Summary Portfolio" -s "first-session"
```
Understanding the Templates

This appendix describes each template, and provides analysis highlights and tips where applicable.

Understanding Load Session Terminology

Note: All the measurements appearing in the various templates are explained in the glossary.

Each run of the agenda body is called a round. A round is composed of transactions. Each transaction can include various combinations of the following:

- Request(s) for a page. The page can include any number of graphics and contents files. Each request for a gif, jpeg, html file, etc., is a single hit.
- Sleep intervals.
- JavaScript functions.

The following illustrates a sample round:

<table>
<thead>
<tr>
<th>Round</th>
<th>Transaction</th>
<th>Transaction</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Page</td>
<td>Sleep</td>
</tr>
<tr>
<td></td>
<td>Hit</td>
<td>Hit</td>
</tr>
<tr>
<td></td>
<td>Page</td>
<td>Page</td>
</tr>
<tr>
<td></td>
<td>Hit</td>
<td>Hit</td>
</tr>
<tr>
<td></td>
<td>Page</td>
<td>Page</td>
</tr>
<tr>
<td></td>
<td>Hit</td>
<td>Hit</td>
</tr>
<tr>
<td></td>
<td>JS function</td>
<td></td>
</tr>
</tbody>
</table>

Figure 36: Sample Round

A hit is composed of several stages, as shown in Figure 37. Figure 37 also shows at which stages a TCP connection starts and ends, and at which stages an HTTP Request and an HTTP Response start and end.
Appendix D. Understanding the Templates

### General Templates

This category of templates provides general statistical information about the Load Session.

#### HTTP Response Status Codes

The HTTP Errors Over Time, HTTP Responses, and HTTP Responses Over Time templates display various HTTP response status messages. The following table lists all HTTP response status codes and their descriptions. For a full description, see http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html.

<table>
<thead>
<tr>
<th>Category</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Informational</td>
<td>100</td>
<td>Continue</td>
</tr>
<tr>
<td></td>
<td>101</td>
<td>Switching Protocols</td>
</tr>
<tr>
<td>Successful</td>
<td>200</td>
<td>OK</td>
</tr>
<tr>
<td></td>
<td>201</td>
<td>Created</td>
</tr>
<tr>
<td></td>
<td>202</td>
<td>Accepted</td>
</tr>
<tr>
<td></td>
<td>203</td>
<td>Non-Authoritative Information</td>
</tr>
<tr>
<td></td>
<td>204</td>
<td>No Content</td>
</tr>
<tr>
<td></td>
<td>205</td>
<td>Reset Content</td>
</tr>
<tr>
<td></td>
<td>206</td>
<td>Partial Content</td>
</tr>
<tr>
<td>Redirection</td>
<td>300</td>
<td>Multiple Choices</td>
</tr>
<tr>
<td></td>
<td>301</td>
<td>Moved Permanently</td>
</tr>
<tr>
<td></td>
<td>302</td>
<td>Found</td>
</tr>
<tr>
<td></td>
<td>303</td>
<td>See Other</td>
</tr>
<tr>
<td></td>
<td>304</td>
<td>Not Modified</td>
</tr>
<tr>
<td></td>
<td>305</td>
<td>Use Proxy</td>
</tr>
<tr>
<td>Category</td>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td></td>
<td>307</td>
<td>Temporary Redirect</td>
</tr>
<tr>
<td>Client Error</td>
<td>400</td>
<td>Bad Request</td>
</tr>
<tr>
<td></td>
<td>401</td>
<td>Unauthorized</td>
</tr>
<tr>
<td></td>
<td>402</td>
<td>Payment Required</td>
</tr>
<tr>
<td></td>
<td>403</td>
<td>Forbidden</td>
</tr>
<tr>
<td></td>
<td>404</td>
<td>Not Found</td>
</tr>
<tr>
<td></td>
<td>405</td>
<td>Method Not Allowed</td>
</tr>
<tr>
<td></td>
<td>406</td>
<td>Not Acceptable</td>
</tr>
<tr>
<td></td>
<td>407</td>
<td>Proxy Authentication Required</td>
</tr>
<tr>
<td></td>
<td>408</td>
<td>Request Timeout</td>
</tr>
<tr>
<td></td>
<td>409</td>
<td>Conflict</td>
</tr>
<tr>
<td></td>
<td>410</td>
<td>Gone</td>
</tr>
<tr>
<td></td>
<td>411</td>
<td>Length Required</td>
</tr>
<tr>
<td></td>
<td>412</td>
<td>Precondition Failed</td>
</tr>
<tr>
<td></td>
<td>413</td>
<td>Request Entity Too Large</td>
</tr>
<tr>
<td></td>
<td>414</td>
<td>Request-URI Too Long</td>
</tr>
<tr>
<td></td>
<td>415</td>
<td>Unsupported Media Type</td>
</tr>
<tr>
<td></td>
<td>416</td>
<td>Requested Range Not Satisfiable</td>
</tr>
<tr>
<td></td>
<td>417</td>
<td>Expectation Failed</td>
</tr>
<tr>
<td>Server Error</td>
<td>500</td>
<td>Internal Server Error</td>
</tr>
<tr>
<td></td>
<td>501</td>
<td>Not Implemented</td>
</tr>
<tr>
<td></td>
<td>502</td>
<td>Bad Gateway</td>
</tr>
<tr>
<td></td>
<td>503</td>
<td>Service Unavailable</td>
</tr>
<tr>
<td></td>
<td>504</td>
<td>Gateway Timeout</td>
</tr>
<tr>
<td></td>
<td>505</td>
<td>HTTP Version Not Supported</td>
</tr>
</tbody>
</table>

**Attempted Connections**

This template displays a bar graph of successful and failed connections, over time. It also displays the Load Size, for reference.
**Analysis Highlights**

Under normal circumstances, you would not expect to see failed connections. Failed connections may indicate a problem.

**Connection Time**

This template displays a bar graph showing the breakdown of connection time into DNS Lookup Time and Connect Time. The template also displays the Load Size, for reference.

- **DNS Lookup Time** – The time it takes to resolve the host name and convert it to an IP address by calling the DNS server. Note that the DNS is checked once per virtual-user, for the whole session.
- **Connect Time** – The time it takes for a Virtual Client to connect to the System Under Test (SUT), in seconds. In other words, the time it takes from the beginning of the HTTP request to the TCP/IP connection. Note that if the Persistent Connection option is enabled in the WebLOAD Console, there may not be a value for Connect Time because the HTTP connection remains open between successive HTTP requests.

**General Session Information**

This template displays the following information about the Load Session:

- Start and end time, and duration.
- The maximum number of virtual clients.
- Which agendas are running.
- General information about the reporter.
- General information about the System under Test (SUT).

This template is useful as an opening page for published reports.

**Tip**

You can customize the look of the General Session Information template by editing the settings of the following parameters: OPEN_COMPANY, OPEN_REPORTER_NAME, OPEN_REPORTER_TITLE, OPEN_SUT_DIAGRAM, OPEN_SUT_NAME, OPEN_SUT_VERSION. Refer to Defining Your Parameter Preferences on page 70.

**HTTP Errors Over Time**

This template displays for each time interval, the number of HTTP client side errors (4xx) and HTTP server side errors (5xx) that occurred during the interval.

The template also displays the Load Size, for reference.
HTTP Responses

This template displays a summary of the HTTP response status messages received during the Load Session. For each type of response status, the template lists the number of responses received and what percentage it represents of all HTTP responses.

Some common response status messages are:

- 200 – OK
- 302 – Found
- 404 – Not Found
- 500 – Internal Server Error

For more information see: http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html.

HTTP Responses Over Time

This template displays the number of HTTP responses at each time interval, for each response status code.

Load Size Summary

This template displays the progress of the Load Session by showing the load size over time. That is, the number of Virtual Clients running over time.

This template provides an understanding of the nature of the test being conducted. All other templates should be analyzed in the context of load size behavior.
**Performance Summary**

This template displays the main performance indicators and changes in Load Size, over time:

- **Load Size** – The number of Virtual Clients running during the last reporting interval.
- **Page Time** – The time it takes to complete a successful upper level request, in seconds. The Page Time is the sum of the Connect Time, Send Time, Response Time, and Process Time for all the hits on a page.
- **Time to First Byte** – The time it takes from when a request is sent until the Virtual Client receives the first byte of data.
- **Response Time** – The time it takes the SUT to send the object of an HTTP request back to a Virtual Client, in seconds. In other words, the time from the end of the HTTP request until the Virtual Client has received the complete item it requested.
- **Hits Per Second** – The number of times the Virtual Clients made an HTTP request, divided by the elapsed time, in seconds. Each request for a gif, jpeg, html file, etc., is a single hit.
- **Throughput** – The average number of bytes per second, transmitted from the SUT to the Virtual Clients running the Agenda during the last reporting interval. In other words, this is the value of the Response Data Size divided by the number of seconds in the reporting interval.

**Analysis Highlights**

Hits Per Second, Page Time, Time to First Byte, and Response Time are ‘lower is better’ measurements. An increase in these measurements as the load increases may indicate performance degradation. Sudden decreases in them may also indicate a problem.

Under normal circumstances, Throughput is expected to grow linearly with the load. A constant throughout on increased load may indicate a bottle-neck (bandwidth, or server capacity). A decreasing throughput may also indicate a problem, such as the server sending less responses or shorter, erroneous responses.

**Response Time Breakdown**

This template displays a bar graph showing the breakdown of response time between Time to First Byte and Receive Time, as well as the Send Time.

- **Send Time** – The time it takes the Virtual Client to write an HTTP request to the SUT, in seconds.
- **Time to First Byte** – The time it takes from when a request is sent until the Virtual Client receives the first byte of data.
- **Receive Time** – The elapsed time between receiving the first byte and the last byte.

The template also displays the Load Size, for reference.
Log and Errors Templates

This category of templates provides information about the errors logged for this Load Session.

**Errors By Severity**

This template displays the total number of errors received, grouped by severity level: Info, Minor Error, Error, and Severe Error.

**Tip**

By default, only warnings (minor errors) and above are displayed. To change the default setting, edit the settings of the MIN_SEVERITY parameter (refer to Defining Your Parameter Preferences on page 70).

**Errors Per Second**

This template displays the number of error messages logged over time, for each level of severity.

**Errors Per Transaction**

This template displays a summary of all failed transactions, and the reason for failure. The following attributes are displayed:

- Transaction Name – The name of the transaction.
- Total Count – The total number of times the transaction was executed.
- Successful Count – The number of successful executions of the transaction.
- Failed Count – The number of failed executions of the transaction.
- Marked Count – The number of times a lower level transaction, meaning a transaction nested within a higher level transaction, failed within the current transaction.

For each type of failure, the template displays a description of the failure and how many times this type of failure occurred.

**Log Messages**

This is a detailed template of all the log messages logged during the Load Session.

Note that WebLOAD automatically stops logging after a certain number of log events.
Tip

By default, only minor errors and above are displayed. To change the default setting, edit the settings of the MIN_SEVERITY parameter (refer to Defining Your Parameter Preferences on page 70).

Log Summary

This template displays a summary of the Load Session’s logged messages. Similar messages are grouped, and their total count shown.

Pages Analysis Templates

This category of templates provides an analysis of the pages requested during the Load Session.

Pages Count

This template displays the total number of pages received over time. This represents the total number of times the Virtual Client made upper level requests (both successful and unsuccessful) during the last reporting interval.

The template also displays the Load Size, for reference.

Total Page Time

This template displays the Page Time, over time.

Page Time is the time it takes to complete a successful upper level request, in seconds. It is the sum of the Connect Time, Send Time, Response Time, and Process Time for all the hits on a page.

The template also displays the Load Size, for reference.

Percentile Templates

This category of templates provides information in the form of percentiles.

A percentile is the value of a variable below which a certain percent of observations fall. For example, if a graph shows 40 Hits Per Second for the 70th percentile, that means that 70 percent of the Hits Per Second observation values are below 40.
**Hits Per Second By Percent**

This template displays the distribution of Hits Per Second values in the session.

Hits Per Second is the number of times the Virtual Clients made an HTTP request, divided by the elapsed time, in seconds. Each request for a gif, jpeg, html file, etc. is a single hit.

For example, if the graph shows 40 Hits Per Second for the 70th percentile, that means that 70 percent of the Hits Per Second observation values are below 40.

**Response Time By Percent**

This template displays the distribution of the following response time values in the session:

- **Response Time** – The time it takes the SUT to send the object of an HTTP request back to a Virtual Client, in seconds. In other words, the time from the end of the HTTP request until the Virtual Client has received the complete item it requested.
- **Time To First Byte** – The time it takes from when a request is sent until the Virtual Client receives the first byte of data.

For example, if the graph shows a Response Time of 1.3 seconds for the 70th percentile, that means that 70 percent of the Response Time observation values are below 1.3 seconds.

**Transaction Response Time By Percent**

For each transaction in the session, this template displays the distribution of the transaction response time values in the session.

For example, if the graph shows a Login Time of 10 seconds for the 80th percentile, that means that 80 percent of the Login Time observation values are below 10 seconds.

**Regression Templates**

This category of templates enables you to compare one selected “Main” session to one or more additional sessions you specify.

Regression is very useful for comparing two sessions that were run on the same Load Template. The purpose is to gauge whether a small change in the System Under Test has degraded the performance.
Appendix D. Understanding the Templates

Most templates available under the Regression category are identical to templates of the same name available under other categories, with the following enhancement: each displayed measure is shown for all the sessions being compared. A given measure calculated for different sessions will appear with the same color, but a different line style. This enables easy comparison between measurements from different sessions.

For example, in the following Pages Count regression chart, two sessions are compared: “MP_Store” and “interesting”. The Load Size measure for both is shown in green, but the line style (dotted, continuous, round points, square points) is different.

**Errors By Severity**

This regression template displays for each Load Session you specified, the total number of errors received, grouped by severity level: Info, Minor Error, Error, and Severe Error.

**Errors Per Second**

For each specified Load Session, this regression template displays the number of error messages logged over time, by severity.

**Failed Transactions**

For each specified Load Session, this regression template displays information about transactions that had failures during the session.

**Full Comparison**

This regression template compares the average values of all measurements from two sessions. It is therefore useful for pinpointing possible disparities in measurements that are not normally compared in regression charts.

The template compares the average values of the second session to the average values of the Main session.

- The higher the ratio between them, the darker the background color of the ratio value.
- A negative ratio denotes a decrease in average measurement value; a positive ratio denotes an increase in average measurement value.

**Analysis Highlights**

If a disparity is found, you can explore it further by creating a detailed report on the suspected measurement using the User Defined Blank Regression Template. Refer to Creating a Regression Chart from the Blank Regression Template on page 29.
General Session Information

This regression template displays the following information about the main Load Session:

- Start and end time, and duration.
- Which agendas are running.
- General information about the reporter.
- General information about the System under Test (SUT).

The template also displays which additional sessions are specified.

This template is useful as an opening page for published reports generated from regression templates.

HTTP Responses

This regression template displays a summary of the HTTP response status messages received during the specified Load Sessions. For each type of response status, the template lists the number of responses received and what percentage it represents of all HTTP responses.

Some common response status messages are:

- 200 – OK
- 302 – Found
- 404 – Not Found
- 500 – Internal Server Error

For more information see: http://www.w3.org/Protocols/rfc2616/rfc2616-sec10.html.

Tip

For a full list of all possible HTTP response status codes, refer to Table 13.

Load Size Summary

For each specified Load Session, this regression template displays the progress of the load session by showing the load size over time. That is, the number of Virtual Clients running over time.

This template provides an understanding of the nature of the tests being conducted. All charts should be analyzed in the context of load size behavior.
Pages Count

For each of the specified Load Sessions, this regression template displays the total number of pages received over time. This represents the total number of times the Virtual Client made upper level requests (both successful and unsuccessful) during the last reporting interval.

The template also displays the Load Sizes, for reference.

Performance Summary

For each of the specified Load Session, this regression template displays the main performance indicators and changes in Load Size, over time:

- **Load Size** – The number of Virtual Clients running during the last reporting interval.
- **Page Time** – The time it takes to complete a successful upper level request, in seconds. The Page Time is the sum of the Connect Time, Send Time, Response Time, and Process Time for all the hits on a page.
- **Time to First Byte** – The time it takes from when a request is sent until the Virtual Client receives the first byte of data.
- **Response Time** – The time it takes the SUT to send the object of an HTTP request back to a Virtual Client, in seconds. In other words, the time from the end of the HTTP request until the Virtual Client has received the complete item it requested.
- **Hits Per Second** – The number of times the Virtual Clients made an HTTP request, divided by the elapsed time, in seconds. Each request for a gif, jpeg, html file, etc., is a single hit.
- **Throughput** – The average number of bytes per second, transmitted from the SUT to the Virtual Clients running the Agenda during the last reporting interval. In other words, this is the value of the Response Data Size divided by the number of seconds in the reporting interval.

Analysis Highlights

The Hits Per Second, Page Time, Time to First Byte and Response Time are ‘lower is better’ measurements. An increase in these measurements as the load increases may indicate performance degradation. Sudden decreases in them may also indicate a problem.

Under normal circumstances, Throughput is expected to grow linearly with the load. A constant throughout on increased load may indicate a bottle-neck (bandwidth, or server capacity). A decreasing throughput may also indicate a problem, such as the server sending less responses or shorter, erroneous responses.
PMM Server-side Statistics

For each of the specified Load sessions, this regression template displays the statistics gathered by the Performance Measurement Monitor.

The selected server side measurements are shown over time. The Load Size is also shown, for reference. Note that server side statistics must be explicitly added at the template definition stage, before executing the load session.

Tip
For information on the PMM and how to add server side statistics, see the WebLOAD Console User Guide.

Response Time

This regression template is used to compare the total response time over time of two or more sessions. The compared Load Size is also displayed, for reference.

Response Time Breakdown

For each of the specified Load Sessions, this regression template displays a bar graph showing the breakdown of response time between Time to First Byte and Receive Time, as well as the Send Time.

- Send Time – The time it takes the Virtual Client to write an HTTP request to the SUT, in seconds.
- Time to First Byte – The time it takes from when a request is sent until the Virtual Client receives the first byte of data.
- Receive Time – The elapsed time between receiving the first byte and the last byte.

For each Load Session, the template also displays the Load Size, for reference.

Slowest Transactions

For each of the specified Load Sessions, this regression template displays the session’s transactions, ordered by the average transaction time, slowest first.

Tip
You can configure the template to show only a certain number or certain percentage of the slowest transactions. To do so, edit the settings of the TRAN_PERCENT or TRAN_QTY parameters (refer to Defining Your Parameter Preferences on page 70).
**Transactions With Most Failures**

For each of the specified Load Sessions, this regression template displays the transactions, ordered by the highest failure count.

**Tip**

You can configure the template to show only a certain number or certain percentage of the top failing transactions. To do so, edit the settings of the TRAN_PERCENT or TRAN_QTY parameters (refer to Defining Your Parameter Preferences on page 70)

**Total Page Time**

For each of the specified Load Sessions, this regression template displays the Page Time, over time.

Page Time is the time it takes to complete a successful upper level request, in seconds. It is the sum of the Connect Time, Send Time, Response Time, and Process Time for all the hits on a page.

The template also displays the Load Sizes, for reference.

**Transactions Over Load**

For each of the specified Load Sessions, this regression template displays the transaction response time compared with Load Size values, for each transaction in the session.

This information can be useful when the load size does not change linearly with time.

**Transactions Over Time**

For each of the specified Load Sessions, this regression template displays changes in transaction time over session running time. It also displays the Load Size, for reference.

**Transactions Summary**

For each of the specified Load Sessions, this regression template displays summary information about the transactions in the session. For each type of transaction, the following information is displayed:

- Transaction Count – Displays the total number of successful and failed transactions.
- Transaction Time – For successful transactions, the table displays Transaction Time statistics: Average, Percentile X%, Max, Min, Standard deviation, and Transactions Per Second
Tip
The default percentile is 90%. To change the default setting, edit the settings of the PERCENTILE parameter (refer to Defining Your Parameter Preferences on page 70).

Tip
You can use the Transactions Over Time and Transaction Response Time By Percent regression templates instead of this template.

Server Side Statistics Templates

This category of templates provides statistical information related to the server.

Imported Statistics

This template displays statistical information related to the server that was imported from an external source.

Tip
For information on how to import external statistics, see the WebLOAD Console User Guide.

Load Generators Health

This template displays basic CPU usage and memory usage statistics, for each Load Generator used in the session.

Use this template to make sure that the Load Generators are not overloaded while running the load. Overloaded Load Generators may not be able to fully load the server, and may skew the test results.

PMM Server-Side Statistics

This template displays the statistics gathered by the Performance Measurement Monitor

The selected server side measurements are shown over time. The Load Size is also shown, for reference. Note that server side statistics must be explicitly added at the template definition stage, before executing the load session.
Transaction Analysis Templates

This category of templates enables you to analyze the Load Session’s transactions. Refer to Understanding Load Session Terminology on page 85 for an explanation of the basic elements of a transaction.

Failed Transactions

This template displays information about transactions that had failures during the session.

The chart depicts failed transactions and failure reasons.

Slowest Transactions

This template displays the session’s transactions, ordered by the average transaction time, slowest first.

Tip
You can configure the template to show only a certain number or certain percentage of the slowest transactions. To do so, edit the settings of the TRAN_PERCENT or TRAN_QTY parameters (refer to Defining Your Parameter Preferences on page 70).

Transaction Counters

This chart shows successful and failed transaction counts for each transaction in the session.

Transaction Response Times

This chart shows the average transaction response time, for each transaction.

Transactions Dashboard

This template displays for each transaction:

- A graph chart of transaction behavior over time.
- A bar chart of successful/failed transactions over time.
• A pie chart of overall success/fail statistics.

**Transactions Over Load**

This template displays for each transaction in the session, the transaction response time compared with Load Size values.

This information can be useful when the load size does not change linearly with time.

**Transactions Over Time**

This template displays changes in transaction time over session running time. It also displays the Load Size, for reference.

**Transactions With Most Failures**

This template displays the transactions, ordered by the highest failure count.

<table>
<thead>
<tr>
<th>Tip</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can configure the template to show only a certain number or certain percentage of the top failing transactions. To do so, edit the settings of the TRAN_PERCENT or TRAN_QTY parameters (refer to Defining Your Parameter Preferences on page 70)</td>
</tr>
</tbody>
</table>

**Statistical Correlation**

Statistical correlation templates are used to pinpoint suspect causes for unusual behavior of a certain measurement.

There are four predefined templates in this category. They differ in the leading measurement (Response Time, Throughput), and in the graphical representation (over time or over the leading measurement). However, you can specify any measurement in any agenda to be the leading measurement, and you can view its correlation to all other measurements either over time or over the leading measurement.

**Response Time Correlation**

This template displays the correlation of specified measurements with the Response Time measurement, over Response Time. If you selected a different leading measurement to correlate to, the chart displays correlation with the leading measurement you selected.
• The Correlation column shows the linear correlation coefficient. It is a number between 0 and 1, with 1 being the highest possible correlation. The measurements are listed in the order of correlation, with the highest first.

• The Direction column indicates whether the correlation is positive (the measurement goes up when the leading measurement goes up, and down when the leading measurement goes down) or negative (the measurement goes up when the leading measurement goes down, and down when the leading measurement goes up).

**Tip**

You can apply a Time Filter that restricts the correlation calculation to a specific time frame, to better focus on a certain behavior of the leading measurement. Refer to **Filtering by Time** on page 39.

### Response Time Correlation Over Time

This template displays the correlation of specified measurements with the Response Time measurement, over time. If you selected a different leading measurement to correlate to, the chart displays correlation with the leading measurement you selected.

• The Correlation column shows the linear correlation coefficient. It is a number between 0 and 1, with 1 being the highest possible correlation. The measurements are listed in the order of correlation, with the highest first.

• The Direction column indicates whether the correlation is positive (the measurement goes up when the leading measurement goes up, and down when the leading measurement goes down) or negative (the measurement goes up when the leading measurement goes down, and down when the leading measurement goes up).

**Tip**

You can apply a Time Filter that restricts the correlation calculation to a specific time frame, to better focus on a certain behavior of the leading measurement. Refer to **Filtering by Time** on page 39.

### Throughput Correlation

This template displays the correlation of specified measurements with the Throughput measurement, over Throughput. If you selected a different leading measurement to correlate to, the chart displays correlation with the leading measurement you selected.

• The Correlation column shows the linear correlation coefficient. It is a number between 0 and 1, with 1 being the highest possible correlation. The measurements are listed in the order of correlation, with the highest first.
The Direction column indicates whether the correlation is positive (the measurement goes up when the leading measurement goes up, and down when the leading measurement goes down) or negative (the measurement goes up when the leading measurement goes down, and down when the leading measurement goes up).

**Tip**

You can apply a Time Filter that restricts the correlation calculation to a specific time frame, to better focus on a certain behavior of the leading measurement. Refer to *Filtering by Time* on page 39.

**Throughput Correlation Over Time**

This template displays the correlation of specified measurements with the Throughput measurement, over time. If you selected a different leading measurement to correlate to, the chart displays correlation with the leading measurement you selected.

- The Correlation column shows the linear correlation coefficient. It is a number between 0 and 1, with 1 being the highest possible correlation. The measurements are listed in the order of correlation, with the highest first.
- The Direction column indicates whether the correlation is positive (the measurement goes up when the leading measurement goes up, and down when the leading measurement goes down) or negative (the measurement goes up when the leading measurement goes down, and down when the leading measurement goes up).

**Tip**

You can apply a Time Filter that restricts the correlation calculation to a specific time frame, to better focus on a certain behavior of the leading measurement. Refer to *Filtering by Time* on page 39.
<table>
<thead>
<tr>
<th>Glossary Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AAT</td>
<td>An older, obsolete WebLOAD utility that was used for recording web session activities as a JavaScript file. (Replaced by WebLOAD IDE.)</td>
</tr>
<tr>
<td>Aborted Rounds</td>
<td>The number of times the Virtual Clients started to run an Agenda but did not complete the Agenda, during the last reporting interval. This might be due to session being stopped either automatically or manually by the user.</td>
</tr>
<tr>
<td>Agenda</td>
<td>Specification of the sequence of HTTP protocol calls sent by Virtual Clients to the SUT (System Under Test). Agendas are written in JavaScript. You can either write Agendas as a text file or generate them automatically using the WebLOAD IDE.</td>
</tr>
<tr>
<td>Application Being Tested (ABT)</td>
<td>See SUT.</td>
</tr>
<tr>
<td>Attempted Connections</td>
<td>The total number of times the Virtual Clients attempted to connect to the SUT during the last reporting interval.</td>
</tr>
</tbody>
</table>
| Automatic Transaction counters         | If you have Automatic Transactions enabled, WebLOAD creates three counters for each GET and POST statement in the Agenda:  
  • The total number of times it occurred  
  • The number of times it succeeded  
  • The number of times it failed during the last reporting interval |
<p>| Average                                | For timers, average is the total amount of time counted by the timer (not the elapsed time) divided by the Count (that is, the total number of readings). For example, the average for Transaction Time is the amount of time it took to complete all the successful transactions divided by the number of successful transactions (the Count). |
| Built-in Timer                         | A timer measures the time required to perform a given task. WebLOAD supports both programmed timers and built-in timers. ROUND TIME is a built-in timer. The ROUND TIME is the time needed for one complete execution of an Agenda. |</p>
<table>
<thead>
<tr>
<th>Glossary Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect Time</td>
<td>The time it takes for a Virtual Client to connect to the System Under Test (the SUT), in seconds. In other words, the time it takes from the beginning of the HTTP request to the TCP/IP connection. The value posted in the Current Value column is the average time it took a Virtual Client to connect to the SUT during the last reporting interval. If the Persistent Connection option is enabled, there may not be a value for Connect Time because the HTTP connection remains open between successive HTTP requests.</td>
</tr>
<tr>
<td>Connection Speed (Bits Per Second)</td>
<td>The number of bits transmitted back and forth between the Virtual Clients and the System Under Test (SUT) divided by the time it took to transmit those bits, in seconds. You can set the Virtual Clients to emulate a particular connection speed during the test, either by using the Variable Connection Speed settings, or by coding the connection speed in the Agenda. If a connection speed is specified for the test, WebLOAD reports it in the Statistics Report. The value posted in the Current Value column is the number (sum) of bits passed per second during the last reporting interval. It should match, very closely, the connection speed you specified for the test.</td>
</tr>
<tr>
<td>Console</td>
<td>The WebLOAD component that manages the test session. The Console performs the following: • Configures Load Session hosts and Agendas • Schedules Load Session Agendas • Configures Goal–Oriented test sessions • Monitors the application's performance under the generated load • Manages the Load Session as it is running, allowing you to pause, stop, and continue Load Session components as needed • Displays the current performance of the SUT • Provides a final performance reports for Probing Clients and Virtual Clients • Manages exporting of performance reports</td>
</tr>
<tr>
<td>Glossary Term</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Count</td>
<td>(For timers only.) The total number of readings (the number of times the item being timed has occurred) for the timed statistic since the beginning of the test. For example, for Transaction Time, Count shows the number of transactions that have been completed.</td>
</tr>
<tr>
<td>Current Slice</td>
<td>The value posted for this reporting interval in the Statistics Report main window.</td>
</tr>
<tr>
<td>Current Slice Average</td>
<td>For per time unit statistics and counters, average is the total of all of the current values for the last reporting interval, divided by the number of readings. For timers, average is the total amount of time counted by the timer (not the elapsed time) divided by the Count (that is, the total number of readings for the last reporting interval). For example, the average for Transaction Time is the amount of time it took to complete all the successful transactions in the last reporting interval, divided by the number of successful transactions (the Current Slice Count).</td>
</tr>
<tr>
<td>Current Slice Count</td>
<td>(For timers only.) The total number of readings (the number of times the item being timed has occurred) for the timed statistic for the last reporting interval. For example, for Transaction Time, Current Slice Count shows the number of transactions that have been completed over the last reporting interval.</td>
</tr>
<tr>
<td>Current Slice Max</td>
<td>The highest value reported for this statistic over the last reporting interval.</td>
</tr>
<tr>
<td>Current Slice Min</td>
<td>The lowest value reported for this statistic over the last reporting interval.</td>
</tr>
<tr>
<td>Current Slice Standard Deviation</td>
<td>The average amount the measurement for this statistic varies from the average over the last reporting interval.</td>
</tr>
<tr>
<td>Current Slice Sum</td>
<td>The aggregate or total value for this statistic in this Agenda over the last reporting interval.</td>
</tr>
<tr>
<td>DNS Lookup Time</td>
<td>The time it takes to resolve the host name and convert it to an IP address by calling the DNS server.</td>
</tr>
<tr>
<td>Failed Connections</td>
<td>The total number of times the Virtual Clients tried to connect to the SUT but were unsuccessful, during the last reporting interval. This number is always less than or equal to the number of failed hits because hits can fail for reasons other than a failed connection.</td>
</tr>
<tr>
<td>Failed Hits</td>
<td>The total number of times the Virtual Clients made an HTTP request but did not receive the correct HTTP response from the SUT during the last reporting interval. Note that each request for each gif, jpeg, html file, etc., is a single hit.</td>
</tr>
<tr>
<td><strong>Glossary Term</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Failed Hits Per Second</td>
<td>The number of times the Virtual Clients did not obtain the correct HTTP response divided by the elapsed time, in seconds.</td>
</tr>
<tr>
<td></td>
<td>The value posted in the Current Value column is the number (sum) of unsuccessful HTTP requests per second during the last reporting interval.</td>
</tr>
<tr>
<td>Failed Pages Per Second</td>
<td>The number of times the Virtual Clients did not obtain the correct response to an upper level request, divided by the elapsed time, in seconds.</td>
</tr>
<tr>
<td></td>
<td>The value posted in the Current Value column is the number (sum) of unsuccessful requests per second during the last reporting interval.</td>
</tr>
<tr>
<td>Failed Rounds</td>
<td>The total number of times the Virtual Clients started but did not complete the Agenda during the last reporting interval.</td>
</tr>
<tr>
<td>Failed Rounds Per Second</td>
<td>The number of times the Virtual Clients started but did not complete an iteration of the Agenda, divided by the elapsed time, in seconds.</td>
</tr>
<tr>
<td></td>
<td>The value posted in the Current Value column is the number (sum) of failed iterations of the Agenda per second during the last reporting interval.</td>
</tr>
<tr>
<td>First Byte</td>
<td>The time it takes a Virtual Client to receive the first byte of data.</td>
</tr>
<tr>
<td>Gallery</td>
<td>See Templates Gallery.</td>
</tr>
<tr>
<td>Goal–Oriented Test</td>
<td>A WebLOAD component enabling you to define the performance goals required, and view the status of your application when it is operating under this performance goal. WebLOAD provides a Goal–Oriented Test Wizard for configuring these performance goals. WebLOAD automatically accelerates the number of Virtual Clients accessing your website until you meet your performance goal.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Goal-Oriented Test Wizard was previously called the Cruise Control Wizard.</td>
</tr>
<tr>
<td>Goal–Oriented Test Wizard</td>
<td>See Goal–Oriented Test.</td>
</tr>
<tr>
<td>Glossary Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hit Time</td>
<td>The time it takes to complete a successful HTTP request, in seconds. Each request for each <em>gif</em>, <em>jpeg</em>, <em>html</em> file, etc., is a single hit. The time of a hit is the sum of the Connect Time, Send Time, Response Time, and Process Time. The value posted in the Current Value column is the average time it took to make an HTTP request and process its response during the last reporting interval.</td>
</tr>
<tr>
<td>Hits</td>
<td>The total number of times the Virtual Clients made HTTP requests to the System Under Test (SUT) during the last reporting interval. For example, a Get statement for a URL retrieves a page. The page can include any number of graphics and contents files. Each request for each <em>gif</em>, <em>jpeg</em>, <em>html</em> file, etc., is a single hit.</td>
</tr>
<tr>
<td>Hits Per Second</td>
<td>The number of times the Virtual Clients made an HTTP request divided by the elapsed time, in seconds. Each request for each <em>gif</em>, <em>jpeg</em>, <em>html</em> file, etc., is a single hit. The value posted in the Current Value column is the number (sum) of HTTP requests per second during the last reporting interval.</td>
</tr>
<tr>
<td>Host</td>
<td>A computer connected via a network, participating in a test session. Each Host in a test session has assigned tasks. A host can act as either a Load Machine or a Probing Client Machine. All hosts participating in a test session must be accessible to the Console over a network. Therefore they must run TestTalk, the network agent.</td>
</tr>
<tr>
<td>HTTP Response Status</td>
<td>WebLOAD creates a row in the Statistics Report for each kind of HTTP status code it receives as an HTTP response from the SUT (redirection codes, success codes, server error codes, or client error codes). The value posted is the number of times the Virtual Clients received that status code during the last reporting interval.</td>
</tr>
<tr>
<td>Integrated Reports</td>
<td>A single configurable report that can integrate both standard performance data, and data from the NT Performance Monitor. This report gives you a more complete picture of the performance of your application. The data to be monitored and the data to be displayed in the report are both configurable in the Console.</td>
</tr>
<tr>
<td>Internet Productivity Pack (IPP)</td>
<td>Provides a set of protocol implementations enabling you to load-test your application using these protocols.</td>
</tr>
<tr>
<td>Glossary Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Java and ActiveX counters           | You can add function calls to your Agendas that enable you to instantiate and call methods and properties in Java and ActiveX components (see the WebLOAD Scripting Guide). If there are ActiveX or Java function calls in the Agenda that you are running, WebLOAD reports three counters for them in the Statistics Report:  
• The total number of times it occurred  
• The number of times it succeeded  
• The number of times it failed during the last reporting interval  
The row heading in the Statistics Report is the name of the function call.                                                                                                                                  |
| Java and ActiveX timers             | You can add function calls to your Agendas that enable you to instantiate and call methods and properties in Java and ActiveX components (see the WebLOAD Scripting Guide). If there are ActiveX or Java function calls in the Agenda you are running, WebLOAD reports timers for them in the Statistics Report.  
The timer value is the average amount of time it took to complete the function call, in seconds, during the last reporting interval.  
The row heading in the Statistics Report is the name of the function call.                                                                                                                                 |
<p>| Load Generator                      | The component of the Load Machine that generates Virtual Clients. Load Generators have the task of bombarding the System Under Test with HTTP protocol call requests as defined in the Agenda. WebLOAD assesses the application’s performance by measuring the response time experienced by the Virtual Clients. The number of Virtual Clients at any given moment is determined by the user.                                                                 |
| Load Generator Machine              | See Load Machine.                                                                                                                                                                                                                                                                                                                          |
| Load Machine                        | A host that runs Load Generators. Load Generators bombard the application under test with a large load, to enable complete scalability and integrity testing.                                                                                                                                                                           |</p>
<table>
<thead>
<tr>
<th>Glossary Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Session</td>
<td>A Load Session includes both the complete Load Template and the results obtained while running that Load Session. A Load Template consists of information about the hosts and Agendas participating in the current Load Session. The Load Template will also include scheduling information. The complete Load Template is illustrated in the Session Tree. Storing a Load Template saves you time when repeatedly running WebLOAD with the same, or even a similar network configuration, since you don’t have to recreate your Load Template from scratch each time you want to start working. Storing Load Session results can be useful when you want to examine results from multiple test sessions or for analyzing test session results.</td>
</tr>
<tr>
<td>Load Size</td>
<td>The number of Virtual Clients running during the last reporting interval.</td>
</tr>
<tr>
<td>Load Template</td>
<td>A Load Template contains the complete Load Session definition, without the test results. A Load Template includes information about the participating hosts and the Agendas used in the current Load Session. The definition also includes scheduling information and the configuration of the Server Monitor and Integrated Reports. The complete Load Template is illustrated in the Session Tree. Storing a Load Template saves you time when repeatedly running WebLOAD with the same, or even a similar network configuration, since you do not have to recreate your Load Template from scratch each time you rerun a test.</td>
</tr>
<tr>
<td>Page Time</td>
<td>The time it takes to complete a successful upper level request, in seconds. The Page Time is the sum of the Connect Time, Send Time, Response Time, and Process Time for all the hits on a page. The value posted in the Current Value column is the average time it took the Virtual Clients to make an upper level request and process its response during the last reporting interval.</td>
</tr>
<tr>
<td>Pages</td>
<td>The total number of times the Virtual Client made upper level requests, both successful and unsuccessful, during the last reporting interval.</td>
</tr>
<tr>
<td>Pages Per Second</td>
<td>The number of times the Virtual Clients made upper level requests divided by the elapsed time, in seconds. The value posted in the Current Value column is the number (sum) of requests per second during the last reporting interval.</td>
</tr>
<tr>
<td>Per Time Unit statistics</td>
<td>Ratios that calculate an average value for an action or process. For example: Transactions Per Second, Rounds Per Second.</td>
</tr>
<tr>
<td><strong>Glossary Term</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Portfolio</td>
<td>A Portfolio enables you to generate a single, inclusive report that contains all the charts generated by the templates included in the portfolio.</td>
</tr>
<tr>
<td>Probing Client</td>
<td>A software program which &quot;bombards&quot; the SUT as a single Virtual Client, to further measure the performance of the SUT. WebLOAD generates exact values for Probing Client performance.</td>
</tr>
<tr>
<td>Probing Client Machine</td>
<td>Hosts running Probing Client software simulating one Virtual Client, and run at the same time as Load Machines.</td>
</tr>
<tr>
<td>Probing Client software</td>
<td>See Probing Client.</td>
</tr>
<tr>
<td>Process Time</td>
<td>The time it takes WebLOAD to parse an HTTP response from the SUT and then populate the document-object model (DOM), in seconds.</td>
</tr>
<tr>
<td></td>
<td>The value posted in the Current Value column is the average time it took WebLOAD to parse an HTTP response during the last reporting interval.</td>
</tr>
<tr>
<td>Receive Time</td>
<td>The elapsed time between receiving the first byte and the last byte.</td>
</tr>
<tr>
<td>Report Portfolio</td>
<td>See Portfolio.</td>
</tr>
<tr>
<td>Resource Manager</td>
<td>Distributes and circulates WebLOAD testing resources (Virtual Clients and Probing Clients) amongst users on a &quot;need to use&quot; basis. The Resource Manager is packaged with a maximum number of Virtual Clients, Probing Clients and Connected Workstation ports, as defined by the WebLOAD package.</td>
</tr>
<tr>
<td></td>
<td>With the Resource Manager, every WebLOAD Console can operate in Standalone Workstation mode or Connected Workstation mode.</td>
</tr>
<tr>
<td>Response Data Size</td>
<td>The size, in bytes, of all the HTTP responses sent by the SUT during the last reporting interval.</td>
</tr>
<tr>
<td></td>
<td>WebLOAD uses this value to calculate Throughput (bytes per second).</td>
</tr>
<tr>
<td>Response Time</td>
<td>The time it takes the SUT to send the object of an HTTP request back to a Virtual Client, in seconds. In other words, the time from the end of the HTTP request until the Virtual Client has received the complete item it requested.</td>
</tr>
<tr>
<td></td>
<td>The value posted in the Current Value column is the average time it took the SUT to respond to an HTTP request during the last reporting interval.</td>
</tr>
<tr>
<td>Glossary Term</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Responses</td>
<td>The number of times the SUT responded to an HTTP request during the last reporting interval. This number should match the number of successful hits.</td>
</tr>
<tr>
<td>Round Time</td>
<td>The time it takes one Virtual Client to finish one complete iteration of an Agenda, in seconds. The value posted in the Current Value column is the average time it took the Virtual Clients to finish one complete iteration of the Agenda during the last reporting interval.</td>
</tr>
<tr>
<td>Rounds</td>
<td>The total number of times the Virtual Clients attempted to run the Agenda during the last reporting interval.</td>
</tr>
<tr>
<td>Rounds Per Second</td>
<td>The number of times the Virtual Clients attempted to run the Agenda, divided by the elapsed time, in seconds. The value posted in the Current Value column is the number (sum) of attempts (both successful and unsuccessful) per second during the last reporting interval.</td>
</tr>
<tr>
<td>Send Time</td>
<td>The time it takes the Virtual Client to write an HTTP request to the SUT, in seconds. The value posted in the Current Value column is the average time it took the Virtual Clients to write a request to the SUT during the last reporting interval.</td>
</tr>
<tr>
<td>Server Performance Measurements</td>
<td>If you selected Performance Monitor statistics for the report, WebLOAD creates a row for them and reports their values in the Statistics Report. For definitions of the statistics, see the Server Monitor Definition dialog box. Be selective when choosing server performance measurements, otherwise the system resources required to manage the data might affect the Console.</td>
</tr>
<tr>
<td>Session Tree</td>
<td>A graphic representation of a Load Template and status. It illustrates the different components of a test session, including Load Machines and Probing Clients, the Agendas that they execute, and their status.</td>
</tr>
<tr>
<td>Single Client</td>
<td>See Probing Client.</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>The average amount the measurement varies from the average since the beginning of the test.</td>
</tr>
<tr>
<td>Glossary Term</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Successful Connections</td>
<td>The total number of times the Virtual Clients were able to successfully connect to the SUT during the last reporting interval.</td>
</tr>
<tr>
<td></td>
<td>This number is always less than or equal to the number of successful hits because several hits might use the same HTTP connection if the Persistent Connection option is enabled.</td>
</tr>
<tr>
<td>Successful Hits</td>
<td>The total number of times the Virtual Clients made an HTTP request and received the correct HTTP response from the SUT during the last reporting interval. Each request for each gif, jpeg, html file, etc., is a single hit.</td>
</tr>
<tr>
<td>Successful Hits Per Second</td>
<td>The number of times the Virtual Clients obtained the correct HTTP response to their HTTP requests divided by the elapsed time, in seconds.</td>
</tr>
<tr>
<td></td>
<td>The value posted in the Current Value column is the number (sum) of successful HTTP requests per second during the last reporting interval.</td>
</tr>
<tr>
<td>Successful Pages Per Second</td>
<td>The value posted in the Current Value column is the number (sum) of successful requests per second during the last reporting interval.</td>
</tr>
<tr>
<td>Successful Rounds</td>
<td>The total number of times the Virtual Clients completed one iteration of the Agenda during the last reporting interval.</td>
</tr>
<tr>
<td>Successful Rounds Per Second</td>
<td>The number of times the Virtual Clients completed an entire iteration of the Agenda, divided by the elapsed time, in seconds.</td>
</tr>
<tr>
<td></td>
<td>The value posted in the Current Value column is the number (sum) of successful iterations of the Agenda per second during the last reporting interval.</td>
</tr>
<tr>
<td>SUT</td>
<td>The system running the Web application currently under test. The SUT (System Under Test) is accessed by clients through its URL address. The SUT can reside on any machine or on multiple machines, anywhere on the global Internet or your local intranet.</td>
</tr>
<tr>
<td>Template</td>
<td>See Load Template.</td>
</tr>
<tr>
<td>Templates Gallery</td>
<td>The Templates Gallery is a single entity that contains predefined templates, user-defined templates, and portfolios.</td>
</tr>
<tr>
<td>Test Program</td>
<td>See Test Script.</td>
</tr>
<tr>
<td>Test Script</td>
<td>The Agenda. This defines the test scenario used in your Load Session. Agendas are written in JavaScript.</td>
</tr>
<tr>
<td>Glossary Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Test Template</td>
<td>See Load Template.</td>
</tr>
<tr>
<td>TestTalk</td>
<td>The network agent. This program enables communication between the Console and the host computers participating in the test.</td>
</tr>
<tr>
<td>Throttle Control</td>
<td>A WebLOAD component that enables you to dynamically change the Load Size while a test session is in progress.</td>
</tr>
<tr>
<td>Throughput (Bytes Per Second)</td>
<td>The average number of bytes per second transmitted from the SUT to the Virtual Clients running the Agenda during the last reporting interval. In other words, this is the amount of the Response Data Size, divided by the number of seconds in the reporting interval.</td>
</tr>
<tr>
<td>Time to First Byte</td>
<td>The time it takes from when a request is sent until the Virtual Client receives the first byte of data.</td>
</tr>
<tr>
<td>User-defined Automatic Data Collection</td>
<td>If you have Automatic Data Collection enabled, WebLOAD creates three counters for each GET and POST statement in the Agenda.</td>
</tr>
<tr>
<td></td>
<td>• The total number of times the Get and Post statements occurred</td>
</tr>
<tr>
<td></td>
<td>• The number of times the statements succeeded</td>
</tr>
<tr>
<td></td>
<td>• The number of times the statements failed during the last reporting interval</td>
</tr>
<tr>
<td>User-defined counters</td>
<td>Your own counters that you can add to Agendas using the SendCounter() and the SendMeasurement() functions (see the WebLOAD Scripting Guide). If there is a user-defined counter in the Agenda that you are running, WebLOAD reports the counter's values in the Statistics Report.</td>
</tr>
<tr>
<td></td>
<td>The row heading is the name (argument) of the counter, that is, the string in parenthesis in the SendCounter() or SendMeasurement() function call.</td>
</tr>
<tr>
<td></td>
<td>The value reported is the number of times the counter was incremented during the last reporting interval.</td>
</tr>
<tr>
<td>Glossary Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User-defined timer</td>
<td>Timers that you can add to Agendas to keep track of the amount of time it takes to complete specific actions (see the WebLOAD Scripting Guide). If there are any timers in the Agendas that you are running, WebLOAD reports their values in the Statistics Report. The row heading is the name (argument) of the timer. That is, the row heading is the string in parenthesis in the <code>SetTimer()</code> function call. The timer represents the time it takes to complete all the actions between the <code>SetTimer()</code> call and its corresponding <code>SendTimer()</code> call, in seconds. The value posted is the average time it took a Virtual Client to complete the actions between the pair of timer calls, in seconds, during the last reporting interval.</td>
</tr>
</tbody>
</table>
| User-defined Transaction counters | Transaction functions that you can add to Agendas for functional tests (see the WebLOAD Scripting Guide). If there is a user-defined transaction function in the Agenda that you are running, WebLOAD reports three counters for it in the Statistics Report:  
  - The total number of times the transaction occurred  
  - The number of times a transaction succeeded  
  - The number of times a transaction failed during the last reporting interval  
    The row heading is the name (argument) of the transaction. That is, the row heading is the string in parenthesis in the `BeginTransaction()` function call. |
| User-defined Transactions timers | A timer for user-defined transaction functions. If there is a user-defined transaction function in the Agenda that you are running, WebLOAD reports a timer for it in the Statistics Report.  
    The row heading is the name (argument) of the user-defined transaction. That is, the row heading is the string in parenthesis in the `BeginTransaction()` function call.  
    The timer represents the average time it took to complete all the actions between the `BeginTransaction()` call and its corresponding `EndTransaction()` call, in seconds, during the last reporting interval. |
<table>
<thead>
<tr>
<th>Glossary Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Client</td>
<td>Artificial entities run by Load Generators. Each such entity is a perfect simulation of a real client accessing the System Under Test (SUT) through a Web browser. Virtual Clients generate HTTP calls that access the SUT. The Load Generators that run Virtual Clients can reside anywhere on the Internet or on your local intranet. Agendas are executed by all the Virtual Clients in parallel, achieving simultaneous access to the SUT. The size of the load on your SUT is determined by the number of Virtual Clients being generated. You may define as many Virtual Clients as needed, up to the maximum supported by your WebLOAD “package”.</td>
</tr>
<tr>
<td>WebLOAD Analytics</td>
<td>WebLOAD Analytics enables you to analyze data and create custom, informative reports after running a WebLOAD test session.</td>
</tr>
<tr>
<td>WebLOAD Console</td>
<td>See Console.</td>
</tr>
<tr>
<td>WebLOAD Integrated Development Environment (IDE)</td>
<td>An easy-to-use tool for recording, creating, and authoring protocol Agendas for the WebLOAD environment.</td>
</tr>
<tr>
<td>WebLOAD Load Template</td>
<td>See Load Template.</td>
</tr>
<tr>
<td>WebLOAD Session</td>
<td>See Load Session.</td>
</tr>
<tr>
<td>WebLOAD Wizard</td>
<td>A WebLOAD Wizard that steps you through the configuration process. Each screen of the WebLOAD Wizard contains text explaining the configuration process. The WebLOAD Wizard enables you to create a basic Load Template. After using the demo, you can use the Console menus to add functionality not available through the WebLOAD Wizard.</td>
</tr>
<tr>
<td>WebRM</td>
<td>See Resource Manager.</td>
</tr>
</tbody>
</table>
Index

A
AAT ▪ 102
Aborted Rounds ▪ 102
Accessing Help ▪ 18
Agenda ▪ 102
Analytics Preferences ▪ 64
Application Being Tested (ABT) ▪ 102
Attempted Connections ▪ 102
Automatic Transaction counters ▪ 102
Average ▪ 102
AXES_SCALE ▪ 70

B
Blank Template ▪ 28, 55
creating chart ▪ 27
creating template ▪ 54
Built-in Timer ▪ 102

C
Categories of templates, creating new ▪ 57
Changing chart settings ▪ 34
Chart template ▪ 52
Charts
changing settings ▪ 34
creating new ▪ 20
generating ▪ 20
modifying ▪ 42
navigating ▪ 29
Preview tab ▪ 29
printing ▪ 26
publishing ▪ 33
Charts area ▪ 17
Command-line mode ▪ 79
Connect Time ▪ 103
Connection Speed (Bits Per Second) ▪ 103
Console ▪ 103
CONTINUOUS_LINE ▪ 70
Copying templates ▪ 58
Count ▪ 104
Creating interactive charts from the Blank Template ▪ 27, 28, 55
Creating new charts ▪ 20
Creating new reports ▪ 43
Creating portfolios ▪ 61
CSV ▪ 33, 45
Current Slice ▪ 104
average ▪ 104
count ▪ 104
max ▪ 104
min ▪ 104
standard deviation ▪ 104
sum ▪ 104

D
Database ▪ 14
Database preferences ▪ 67
Date, searching by ▪ 50
Defining
Analytics preferences ▪ 64
database preferences ▪ 67
parameter preferences ▪ 68
Defining your preferences ▪ 64
Deleting Load Sessions ▪ 51
Deleting templates ▪ 59
DNS Lookup Time ▪ 104
Doc ▪ 33, 45

E
Exporting data to excel ▪ 32

F
Failed Connections ▪ 104
Failed Hits ▪ 104
Failed Hits Per Second ▪ 105
Failed Pages Per Second ▪ 105
Failed Rounds ▪ 105
Failed Rounds Per Second ▪ 105
File system, structure ▪ 75
Filtering
by time ▪ 38
selecting Agendas ▪ 36
selecting measurements ▪ 36
statistic-based time ▪ 39
First Byte ▪ 105
FOOTERLOGO ▪ 70
FOOTERTEXT ▪ 71
<table>
<thead>
<tr>
<th>G</th>
<th>Gallery • See Templates Gallery</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generating charts • 20</td>
<td></td>
</tr>
<tr>
<td>Generating reports • 43</td>
<td></td>
</tr>
<tr>
<td>Getting started • 15</td>
<td></td>
</tr>
<tr>
<td>Glossary • 102</td>
<td></td>
</tr>
<tr>
<td>Goal-Oriented Test • 105</td>
<td></td>
</tr>
<tr>
<td>Goal-Oriented Test Wizard • 105</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>H</th>
<th>HEADERLOGO • 71</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEADERTEXT • 71</td>
<td></td>
</tr>
<tr>
<td>Help, accessing • 18</td>
<td></td>
</tr>
<tr>
<td>Hit Time • 106</td>
<td></td>
</tr>
<tr>
<td>Hits • 106</td>
<td></td>
</tr>
<tr>
<td>Hits Per Second • 106</td>
<td></td>
</tr>
<tr>
<td>Host • 106</td>
<td></td>
</tr>
<tr>
<td>HTML • 33, 45</td>
<td></td>
</tr>
<tr>
<td>HTTP Response Status • 106</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I</th>
<th>Importing Load Sessions • 49</th>
</tr>
</thead>
<tbody>
<tr>
<td>Importing new templates • 60</td>
<td></td>
</tr>
<tr>
<td>Integrated Reports • 106</td>
<td></td>
</tr>
<tr>
<td>Interactive charts</td>
<td></td>
</tr>
<tr>
<td>customizing • 30</td>
<td></td>
</tr>
<tr>
<td>tools • 30</td>
<td></td>
</tr>
<tr>
<td>Internet Productivity Pack (IPP) • 106</td>
<td></td>
</tr>
<tr>
<td>Introduction • 7</td>
<td></td>
</tr>
<tr>
<td>iReport • 59</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>J</th>
<th>JasperSoft iReport, using • 59</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java and ActiveX counters • 107</td>
<td></td>
</tr>
<tr>
<td>Java and ActiveX timers • 107</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>L</th>
<th>Launching WebLOAD Analytics • 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Generator • 107</td>
<td></td>
</tr>
<tr>
<td>Load Generator Machine • 107</td>
<td></td>
</tr>
<tr>
<td>Load Machine • 107</td>
<td></td>
</tr>
<tr>
<td>Load Session • 108</td>
<td></td>
</tr>
<tr>
<td>Load Sessions</td>
<td></td>
</tr>
<tr>
<td>deleting • 51</td>
<td></td>
</tr>
<tr>
<td>importing • 49</td>
<td></td>
</tr>
<tr>
<td>searching for • 50</td>
<td></td>
</tr>
<tr>
<td>selecting • 21</td>
<td></td>
</tr>
<tr>
<td>working with • 49</td>
<td></td>
</tr>
<tr>
<td>Load Size • 108</td>
<td></td>
</tr>
<tr>
<td>Load Template • 108</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>M</th>
<th>Managing template categories • 57</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master template • 42</td>
<td></td>
</tr>
<tr>
<td>MAX_Y_AXES • 71</td>
<td></td>
</tr>
<tr>
<td>MIN_SEVERITY • 71</td>
<td></td>
</tr>
<tr>
<td>Modifying chart parameters • 42</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>N</th>
<th>Navigating through charts • 29</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation area • 17</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>O</th>
<th>Online Help • 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPEN_COMMENTS • 70</td>
<td></td>
</tr>
<tr>
<td>OPEN_COMPANY • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_REPORTER_NAME • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_REPORTER_TITLE • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_SUT_DIAGRAM • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_SUT_NAME • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_SUT_VERSION • 72</td>
<td></td>
</tr>
<tr>
<td>Opening portfolios • 62</td>
<td></td>
</tr>
<tr>
<td>Opening recently used reports • 47</td>
<td></td>
</tr>
<tr>
<td>Opening saved reports • 47</td>
<td></td>
</tr>
<tr>
<td>Overview • 11</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>P</th>
<th>Page Time • 108</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pages • 108</td>
<td></td>
</tr>
<tr>
<td>Pages Per Second • 108</td>
<td></td>
</tr>
<tr>
<td>Parameter preferences • 68</td>
<td></td>
</tr>
<tr>
<td>Parameters</td>
<td></td>
</tr>
<tr>
<td>adding to template • 73</td>
<td></td>
</tr>
<tr>
<td>applying global parameters • 73</td>
<td></td>
</tr>
<tr>
<td>AXES_SCALE • 70</td>
<td></td>
</tr>
<tr>
<td>CONTINUOUS_LINE • 70</td>
<td></td>
</tr>
<tr>
<td>FOOTERLOGO • 70</td>
<td></td>
</tr>
<tr>
<td>FOOTERTEXT • 71</td>
<td></td>
</tr>
<tr>
<td>HEADERLOGO • 71</td>
<td></td>
</tr>
<tr>
<td>HEADERTEXT • 71</td>
<td></td>
</tr>
<tr>
<td>MAX_Y_AXES • 71</td>
<td></td>
</tr>
<tr>
<td>MIN_SEVERITY • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_COMMENTS • 70</td>
<td></td>
</tr>
<tr>
<td>OPEN_COMPANY • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_REPORTER_NAME • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_REPORTER_TITLE • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_SUT_DIAGRAM • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_SUT_NAME • 71</td>
<td></td>
</tr>
<tr>
<td>OPEN_SUT_VERSION • 72</td>
<td></td>
</tr>
</tbody>
</table>
Successful Rounds Per Second • 111
SUT • 111
System overview
repositories • 14
workflow • 11

T
Technical Support • 10
Technical Support Website • 9
Template • 111
Template categories
creating new • 57
deleting • 59
renaming • 58
Template structure • 52
Templates
copying • 58
creating categories • 57
deleting • 59
deleting categories • 59
descriptions • 83
importing new • 60
JasperSoft iReport • 59
managing categories • 57
renaming • 58
renaming categories • 58
structure • 52
user-defined, creating • 53
working with • 52
Templates Gallery
definition • 111
location • 14
working with templates • 52
Test Program • 111
Test Script • 111
Test Template • 112
TestTalk • 112
THREAHOLD_TOLERANCE • 72
THRESHOLD • 72
Throttle Control • 112
Throughput (Bytes Per Second) • 112
Time to First Byte • 112
Time, filtering by • 38
TIME_FILTER_FROM_BEGINNING • 72
TIME_FILTER_FROM_END • 72
TIME_FORMAT • 73
TOP_RESULTS • 73
TRAN_PERCENT • 73
TRAN_QTY • 73
Typographical Conventions • 8

U
Understanding the statistics • 78
Understanding the User Interface • 17
User-defined Automatic Data Collection • 112
User-defined counters • 112
User-defined templates, creating • 53
User-defined timer • 113
User-defined Transaction counters • 113
User-defined Transactions timers • 113
Using JasperSoft iReport • 59

V
Viewing options’ • 29
Virtual Client • 114

W
WebLOAD Analytics • 114
WebLOAD Analytics file system structure • 75
WebLOAD Analytics Repositories • 14
WebLOAD Console • 114
WebLOAD Documentation • 7
WebLOAD Integrated Development Environment (IDE) • 114
WebLOAD Load Template • 114
WebLOAD Session • 114
WebLOAD Wizard • 114
Where to Get More Information • 9
Workflow • 11
Working with Load Sessions • 49
Working with portfolios • 61
Working with templates • 52

X
XLS • 33, 45